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Healthy skin. Positive outcomes.



Healthy Skin. Positive Outcomes.



This is our quest. Keeping peristomal
skin healthy. The way it was meant to be.

Hollister Ostomy Care is dedicated

to delivering products that provide an
optimum fit to prevent leakage, along
with the best skin interface formulations
to protect and maintain healthy skin.

We believe every unigue person with a
stoma deserves a customized solution,
and the positive outcomes that can result.
Our products and services are designed
to do just that.

Thank you for partnering with us on
our journey.
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Hollister Secure Start Services

Personalized Patient Support

Support Throughout the Continuum of Care

We are proud to offer dedicated support for each and
every patient we serve along the continuum of care.
Hollister Secure Start services provide a lifetime of
personalized support for our members.

Our team is focused on helping patients with:
« Finding the right product fit
» Navigating insurance coverage
« |dentifying supplier options
* Providing condition specific education
¢ And more!

To learn more, call us at 1.888.808.7456.

The Hollister logo and
Secure Start are trademarks of
Hollister Incorporated.
© 2020 Hollister Incorporated.

£ Hollister

Why Secure Start Services
for Your Patients?

Secure Start services helps patients —regardless of
product brand they use—to get back to living life with
confidence and security. We understand this is a process
that takes time. That’s why our no-cost, personalized
service is available for the lifetime of their ostomy.

THE RIGHT PRODUCTS —based on your product
recommendations, we help patients find the ostomy
products that best fit their needs throughout the
lifetime of their ostomy.

OSTOMY SMART EDUCATION —easy access to
important care information and lifestyle resources that
support the goal of maintaining healthy peristomal
skin from the start.

S

SUPPLIER MATCHING —connects patients with a
supplier of their choice based on their insurance plan
for the products you recommend.

WOC ACCESS —if the need arises, an ostomy nurse
is available to assist with product questions.

(o) (2

ENROLLMENT MADE EASY

Obtaining written patient consent to enroll in Secure Start
services is an important step. At Hollister, we prioritize
patient privacy —giving patients comfort that their
information will remain confidential and will be shared only
with those they wish to hear from. Having patient consent
on file helps us provide proactive ostomy education and
product information throughout their journey.

Digital
Easy mobile enroliment with Enroll on the Go

Fax

Fax enrollment form to 1.800.398.2341.
If you have any questions about the
enrolliment process, please call your Hollister Secure Start
services coordinator at 1.888.808.7456. Learn more at
www.securestartservices.com.




How to Use The Hollister
Product Catalog

Hollister has created this simplified catalog to help
our customers find what they need in a quick and
efficient manner.

If you...

know the stock number (or stock series
number)

Go to the numeric index at the back of the catalog
on pages 98-99 to find the page number where

it appears.

If you...

know the product brand or series name
Go to the Table of Contents on pages 2-3 to find
the page number where it appears or reference the
Product Name Index on pages 100-101.

If you...

know the HCPCS code

Go to the HCPCS Code Index at the back of the
catalog on page 108.

Fit and Formulation

Promoting healthy peristomal skin

It drives everything we do. In order to
promote healthy skin, it is important to
understand that the fit of the pouching
system as well as the formulation of the
skin barrier go hand in hand.

A pouching system will not maintain a
good seal without the proper fit. Without
the correct formulation, the skin around
the stoma can be at risk for complications.

Our goal is to help keep the skin around
your patient’s stoma as healthy as the skin
on the rest of their body.



Choosing the Right Skin Barrier

FIT is critical to get a good seal around the stoma to prevent leakage

Barrier Examples Possible Clinical Case Scenarios

Flat Skin Barrier

e Flat peristomal plane

e Adequate stoma protrusion
e Centered stoma opening

Flat Skin Barrier

Flexible Convexity

e Stoma flush with skin

e Uneven peristomal plane

e Off-centered stoma opening

Flat Skin Barrier with Round or
Oval Convex Barrier Ring

Oval barrier ring shown in picture.

Integrated Soft Convex Barrier Soft Convexity

e Gentle pressure required to
peristomal plane

e Flush stoma

e Peristomal injury

Integrated Convex Barrier Firm Convexity

e Creases or folds in peristomal plane
e Off-centered stoma opening
e Stoma retracted below skin surface

Integrated Convex Barrier with
Round or Oval Convex Barrier Ring

Firm Convexity with More Depth
e Recessed or flushed stoma
e Uneven abdominal contours
e Off-centered stoma opening

Round barrier ring shown in picture.

Prior to use, be sure to read the Instructions for Use for information regarding
intended use, contraindications, warnings, precautions and instructions.



Choosing the Right Skin Barrier Formulation

FORMULATION is the customized ingredients responsible for adhesion,
erosion resistance and absorption that must be carefully formulated to
create an environment where healthy skin can thrive.

Types of Skin Barrier Formulations and Their Performance

The Hollister Ostomy Care portfolio has a multitude of formulation options
that are designed to help ensure an optimal skin interface is possible for
every patient.

Extended Wear

CeraPlus Skin Barrier

e Contains all skin barrier characteristics (adhesion, absorption and
erosion resistance) and is infused with ceramide — a naturally
occurring lipid in the skin which protects against dryness

e |ts formulation is designed to help protect the skin’s
natural moisture barrier and help maintain good peristomal
skin health

Flextend Skin Barrier
e Durable with high resistance to erosion

e Swells when it comes in contact with liquid to help form a seal
between the skin and the stoma

e High initial tack and suitable for those who perspire heavily
e Strong adhesion and flexibility

FormaFlex Skin Barrier

e Helps to provide a secure peristomal skin seal as it will maintain its
shape after being stretched or shaped

e Provides an easy-to-customize opening due to barrier material

e Fasy to shape to individual stomas without the use
of scissors

10

Standard Wear

FlexWear Skin Barrier

e Good halance of durability and gentleness providing moderate adhesion,
and can handle frequent or infrequent pouch changes

e Resistant to fluid erosion and tends to hold its shape in the presence
of fluids

e Suitable for all skin types, depending on change frequency
e Designed to be worn more than one day

SoftFlex Skin Barrier
e Appropriate choice for:

— Those who have thin, fragile, or sensitive skin (such as those who
have undergone chemo/radiation therapy)

— People who desire frequent removal
e Designed to limit skin damage as its gentle to the skin, which allows for
frequent pouch changes

e Thin and flexible without compromising security

Karaya 5 Skin Barrier

e Well-suited for sensitive skin or in some cases where allergic reactions
to synthetic barriers has occurred

e Mildly adhesive — needs a belt to secure pouching system

Combined with the flexible and customizable fit choices we offer in our
pouching systems, barrier styles and accessories, you can count on the
right combination of fit and formulation for your patients.

Pouch and barrier fit options come in both 1 piece and 2 piece options.
® Flat

® Convex

® Soft Convex

11
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Ceramide Products




Ceramide Products

Transforming the skin health
conversation

At Hollister Ostomy Care, we believe
peristomal skin deserves better. In fact,
we think we should expect the skin
around the stoma to be as healthy as the
skin on the other side of the abdomen.

That’s why we’ve made the pursuit of
healthy skin our priority.

The CeraPlus skin barrier is formulated to
support healthy skin from Day One. The
ceramide-infused barrier is designed to
help protect the skin’s natural moisture
barrier. Healthy skin can remain healthy
through pouching changes, and support
an appropriate fit around the stoma.



Maintaining the Right Environment

E——

Makes all the Difference

Available on Premier One-Piece and
New Image Two-Piece Pouching Systems

The CeraPlus Skin Barrier with Remois Technology*

At Hollister, we realize the importance of healthy peristomal skin.
Our newest skin barrier is infused with ceramide, the skin’s naturally
occurring protection against dryness. The CeraPlus skin barrier

is designed to help protect the skin’s own moisture barrier, and is
available on Premier one-piece and New Image two-piece pouching
systems. This means you can enjoy the same pouch and skin barrier

features from Hollister that you’ve come to rely on—and more!

The CeraPlus skin barrier from Hollister Ostomy Care—because

peristomal skin deserves better.

X
Remois

*Remois is a technology of Alcare Co., Ltd.

. Ostomy Care
% HOHlSter Healthy skin. Positive outcomes.
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Ceramide-Infused Products

The CeraPlus Skin Barrier delivers both
Fit and Formulation

Ceramide-Infused Barrier

e Protects the skin's natural moisture barrier

e Decreases TEWL (transepidermal water loss) from damaged or
eroded skin

e Maintains peristomal skin health

Color Matching System
Two-Piece Pouching Systems

To help you select compatible New Image pouching system components,

every box label is color-coded.

1. Select the skin barrier flange size with the appropriate barrier stoma
opening and note its color code.

2. Select a suitable pouch with the desired features in the
matching color.

Flange Sizes:

1-3/4" (44 mm)

2-1/4" (57 mm)

2-3/4" (70 mm)

4" (102 mm)

NOTE: All stock numbers shaded in gray throughout

this catalog denote ceramide-infused products.

Look for the convex and soft convex symbols:

Coowvex € conn

CeraPlus Flat Skin Barriers with Integrated Floating Flange

£ o 1120x (CUT-TO-FIT) Box of 5
* > CeraPlus (extended wear) Skin Barrier Ceramide
» With Tape Border
HCPCS: A4409
Stock No Flange Size For Stomas Up To
11202 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
11203 @ 2-1/4" 57 mm) 1-3/4" (44 mm)
11204 @ 2-3/4" 70 mm) 2-1/4" (57 mm)
o 1510x (CUT-TO-FIT) Box of 5
. > CeraPlus (extended wear) Skin Barrier Ceramide
— » Without Tape Border
HCPCS for 15102, 15103: A4409
HCPCS for 15104: A4410
Stock No Flange Size For Stomas Up To
15102 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
15103 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
15104 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

CeraPlus Convex Skin Barriers with Integrated Floating Flange

¢~ 1140x (CUT-TO-A) Box of 5
%@‘ > CeraPlus (extended wear) Skin Barrier (
=" » \With Tape Border CONVEX
HCPCS: A4407 Ceramide
Stock No Flange Size For Stomas Up To
11402 @& 1-3/4" (44 mm) 1" (25 mm)
11403 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
11404 @@ 2-3/4" 70 mm) 2" (51 mm)
= @ 1530x (CUT-TO-FIT) Box of 5
v > CeraPlus (extended wear) Skin Barrier
- » Without Tape Border < comvex
HCPCS for 15302, 15303: A4407 Ceramide
HCPCS for 15304: A4408
Stock No Flange Size For Stomas Up To
15302 @& 1-3/4" (44 mm) 1" (25 mm)
15303 @ 2-1/4" 57 mm) 1-1/2" (38 mm)
15304 @ 2-3/4" 70 mm) 2" (51 mm)
o 1150x (PRE-SIZED) Box of 5
> CeraPlus (extended wear) Skin Barrier (
> With Tape Border CONVEX
HCPCS: A4407 Ceramide
Stock No Flange Size Barrier Opening
11503 @& 1-3/4" (44 mm) 7/8" (22 mm)
11504 @ 1-3/4" (44 mm) 1" (25 mm)
11505 @ 2-1/4" (57 mm) 1-1/8" (29 mm)
11506 @ 2-1/4" (57 mm) 1-1/4" (32 mm)

15



Ceramide-Infused Products

CeraPlus Convex Skin Barriers with Integrated Floating Flange

Premier One-Piece Pouching Sy.

(continued)
UUZLSEIEIOH ) S °f < Drainable Pouches with CeraPlus Flat Barriers
» CeraPlus (extended wear) Skin Barrier C
» Soft Convex CONVEX 8931 (CUT-TO-FIT) Box of 10
> With Tape Border Ceramide - > Drainable Pouch 3
HCPCS: A4407 # > CeraPlus (extended wear) Skin Barrier Ceramide
. » With Tape Border
Stock No Flange Size For Stomas Up To > Without Integrated AF300 Filter
1702 & -3/4 (44 mm) 1" (25 mm) > Lock 'n Roll Microseal Closure
H;gi 3 % ;jﬁ % mmg 1’1/3-- Eg? Qﬁg > With ComfortWear Panels — Body Side Only
HCPCS: A4388
. Ultra-Clear
11ng (PRE-SIZED) . ) Box of 5 Stock No For Stomas Up To Pouch Length
> CeraPlus (extended wear) Skin Barrier ~ SOFT = :
S S ETE C< cohoix 8931 2-1/2" (64 mm) 12" (30 cm)
> With Tape Border Ceramide
HCPCS: A4407 8901 (CUT-TO-FIT) Box of 10
: S » Drainable Pouch p
Stock No Flange Size For Stomas Up To S . . Ceramide
11903 & 1-3/4" (44 mm) 7/8" (22 mm) e g vcv?trr?/;/us (ethegded wear) Skin Barrier
11904 @& 1-3/4" (44 mm) 1" (25 mm) o It lape boraer )
11905 @ 2-1/4" (57 mm) 1-1/8" (29 mm) » With Integrated AF300 Filter
11906 @ 2-1/4" (57 mm) 1-1/4" (32 mm) > Lock 'n Roll Microseal Closure
> With Comforti/ear Panels — Both Sides
HCPCS: A5056
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8901 2-1/2" (64 mm) 12" (30 cm)
The CeraPlus Skin Barrier : 89X (PRE-SIZED) Box of 10
delivers both Fit and Formulation = > Drainable. Pouch Ceramide
> CeraPlus (extended wear) Skin Barrier
) — » With Tape Border
Ao - » With Integrated AF300 Filter
Ceramide-Infused Barrier > Lock 'n Roll Microseal Closure
* Protects the skin's natural moisture barrier > With ComfortWear Panels — Both Sides
. HCPCS: A5056
¢ Decreases TEWL (Transepidermal water loss) Beige wi¥iewiing Option
from damaged or eroded skin . Stock No Barrier Opening Pouch Length
« Maintains peristomal skin health %:%Eﬁ, o 3/t G ) el
== 8935 1-3/8" (35 mm) 12” (30 cm)
OF i) 8940 1-9/16" (40 mm) 12" (30 cm)

16 17
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Ceramide-Infused Products

Drainable Pouches with GeraPlus Soft Convex Barriers

Drainable Pouches with GeraPlus Convex Barriers

891xx (CUT-TO-FIT) Box of 5
» Drainable Pouch
> CeraPlus (extended wear) Skin Barrier < convex

_y » With Tape Border Ceramide
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels — Both Sides
HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8914 1" (25 mm) 12" (30 cm)
8918 1-1/2" (38 mm) 12" (30 cm)
89111 2" (51 mm) 12" (30 cm)
898xx (CUT-TO-FIT) Box of 5

» Drainable Pouch

> CeraPlus (extended wear) Skin Barrier < comex
> With Tape Border Ceramide
» Without Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

> With Belt Tabs

» With ComfortWear Panels — Body Side Only

HCPCS Code: A4390

Ultra-Clear

g 895xx (CUT-TO-FIT) Box of 5
— > Drainable Pouch -~ SOFT
% > Soft Convex ( CON\_IEX

= » CeraPlus (extended wear) Skin Barrier ~ Ceramide
> With Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With ComfortWear Panels — Both Sides
HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8954 1" (25 mm) 12" (30 cm)
8958 1-1/2" (38 mm) 12" (30 cm)
89511 2-1/8" (55 mm) 12" (30 cm)
> 896X (PRE-SIZED) Box of 5
== > Drainable Pouch SOFT
> Soft Convex CCONVEX
Ny > CeraPlus (extended wear) Skin Barrier Ceramide
- » With Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels — Both Sides
HCPCS: A5057
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8960 3/4" (19 mm) 12 (30 cm)
8961 7/8 (22 mm) 2" (30 cm)
8962 1" (25 mm) 2” (30 cm)
8963 1-1/8" (29 mm) 12" (30 cm)

Stock No For Stomas Up To Pouch Length
8984 1" (25 mm) 12" (30 cm)
8988 1-1/2" (38 mm) 12" (30 cm)
89811 2" (51 mm) 12" (30 cm)

899X (PRE-SIZED) Box of 5

» Drainable Pouch C
> CeraPlus (extended wear) Skin Barrier CONVEX

— » With Tape Border Ceramide
- > With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
> With ComfortWear Panels — Both Sides
HCPCS: A5057
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8990 3/4" (19 mm) 2" (30 cm)
8991 7/8" (22 mm) 2" (30 cm)
8992 1" (25 mm) 2" (30 cm)
8993 1-1/8" (29 mm) 2" (30 cm)

19
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Ceramide-Infused Products

Urostomy Pouches with GeraPlus Soft Convex Barriers

8413xx (CUT-TO-FIT)
> Urostomy Pouch
> Anti-Reflux Valve
» CeraPlus (extended wear) Skin Barrier CCONVEX
> With Tape Border Ceramide
> With Belt Tabs

> With ComfortWear Panels — Body Side Only
Upgraded Design Features:

» Multi-Chamber Design

» Softer, Streamlined Tap

» Drain Valve Indicator

HCPCS: A4430

Box of 5
includes 1 adapter

Ultra Clear Stock No For Stomas Up To Pouch Length
84134 1" (25 mm) 9" (23 cm)
84138 1-1/2" (38 mm) 9" (23 cm)
841311 2-1/8" (55 mm) 9" (23 cm)

Upgraded Design

"Jm“\cy l

841X (PRE-SIZED)

» Urostomy Pouch
> Anti-Reflux Valve
» CeraPlus (extended wear) Skin Barrier CCONVEX

Box of 5
includes 1 adapter

< > W!th Tape Border Ceramide
> With Belt Tabs
» With ComfortWear Panels — Body Side Only
Upgraded Design Features:
» Multi-Chamber Design
» Softer, Streamlined Tap
» Drain Valve Indicator
HCPCS: A4430
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8412 3/4" (19 mm) 9" (23 cm)
8413 7/3 (22 mm) 9" (23 cm)
8414 1" (25 mm) 9" (23 cm)
8415 1-1/8" (29 mm) 9" (23 cm)

Non Sterile Kits — Drainable

1960x Box of 5

Colostomy/lleostomy Kit includes: :

> (1) 1120x CeraPlus (extended wear) Ceramide
Skin Barrier with Tape Border

> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
Pouch Film

» Single-Use Package

> With ComfortWear Panels-Body Side Only

HCPCS: A5063 + A4414

Ultra-Clear Flange
Stock No Size For Stomas Up To
19602 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19603 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19604 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
; & 1980x Box of 5
©, Colostomy/lleostomy Kit includes: Ceramide

> (1) 1120x CeraPlus (extended wear)
Skin Barrier with Tape Border
> (1) 1817x (Clamp Closure) Ultra-Clear Pouch Film
> Single-Use Package
> With ComfortWear Panels-Body Side Only
> Clamp Included

HCPCS: A5063 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19802 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19803 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19804 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

Non Sterile Kits — Urostomy

2

1990x Box of 5

Urostomy Kit includes: :

> (1) 1120x CeraPlus (extended wear) Ceramide
Skin Barrier with Tape Border

> (1) 1892x with ComfortWear Panels (Ultra-Clear Pouch Film)

> (1) 7331 Urostomy Drain Tube Adapter
> Single-Use Package
» With ComfortWear Panels-Body Side Only

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19902 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19903 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19904 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

21



Ceramide-Infused Products

Infused with the Science

omy Accessories

of Skin Health —— Adapt CeraRing Flat Barrier Rings
4 ' o 8xx Box of 10
: E/E(Ia:;‘g;lglx; (Seg(l;ltzied wear) with Ceramide Ceramide
HCPCS: A4385
Stock No Outer Diameter Thickness
8805 2" (48 mm) 4.5 mm
8815 2" (48 mm) 2.3 mm €D

Adapt CeraRing Convex Barrier Rings

o & 895xx Box of 10
——
e o > Round Convex Barrier Rings (

% » Flextend (extended wear) with Ceramide CONVEX

HCPCS: A4411 Ceramide

Stock No Inner Diameter
89520 13/16" (20 mm) — can be stretched to 1" (25 mm)
89530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
89540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)

Adapt CeraRing Oval Convex Barrier Rings

oo 896xx Box of 10

Adapt CeraRing Barrier Ring > QOval Convex Barrier Rings
©O . Fextend (extended wear) with Ceramide < cowex

Sealed with the confidence

i : Ceramide
of ceramide HCPCS: Ad4411
Stock No Inner Diameter
Adapt barrier ring technology was 89601 7/8" x 1-1/2" (22 mm x 38 mm)
— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)

introduced more than 10 years ago. Its 89602 1-3/16" x 1-7/8" (30 mm x 48 mm)

< — can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
ability to be stretched and shaped to help 89603 1-1/2" x 2-3/16" (38 mm x 56 m|

m)
— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)

minimize the risk of leakage and protect the peristomal skin

makes it a favorite among WOC nurses.

Now, innovation has reached the next level, with the introduction

of Adapt CeraRing.

Infused with ceramide—a natural component of the skin—
Adapt CeraRing is designed to support the healthy peristomal
skin your patients deserve. Ceramides help protect the skin’s
natural moisture barrier and help prevent water loss that may

lead to damage and dryness.

Experience the confidence of ceramide—try Adapt CeraRing today.

. Ostomy Care For a complete list of Hollister products, refer to the comprehensive
HOIllSter» Healthy skin. Positive outcomes. Hollister product catalog online at www.hollister.com.
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Healthy Skin:

Keeps moisture in and irritants out

Dry or
Irritants cold air
and bacteria

Follow the evidence
to help ensure —
healthy skin

) ] Low TEWL
> value = higher

Water retained skin integrity?

After surgery: Peristomal skin starts heal‘[hy Ceramides are abundant in healthy skin.

They form a waterproof barrier to help keep
moisture in and bacteria out.

)
o/ = Ceramides

Top layers of the epidermis are removed

Damaged Skin:

with every barrier Change' Allows moisture out and irritants in

It's unavoidable, and the damage isn’t Water Iritants ~ Water  Dry or
loss and bacteria  loss cold air
always visible. A A
(+) -
N\ R Higher TEWL
() A value = lower
. . . T . A A skin integrity®
Epidermal stripping is linked to increased ¢

levels of transepidermal water loss
(TEWL)™

References:

1. McNichol L, Lund C, Rosen T, Gray M. Medical adhesives and patient safety: state of the science:
consensus statements for the assessment, prevention, and treatment of adhesive-related
skin injuries. J Wound Ostomy Continence Nurs. 2013;40(4):365-380.

2. Grove G, Houser T, Sibbald G, Salvadalena G. Measuring epidermal effects of ostomy skin barriers.
Skin Res Technol. 2019;25:179-186. https://doi.org/10.1111/srt.12630

3. Nybaek H, Lophagen S, Karlsmark T, Bang Knudsen D, Jemec GBE. Stratum corneum integrity as a
predictor for peristomal skin problems in ostomates. Br J Dermatol. 2010;162:357-361.

Damaged skin contains fewer ceramides.

& = Water droplet illustrates moisture loss from skin.
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Clinical Trial Results

The Results are Clear: CeraPlus Skin Barrier Helps
Ensure Healthy Skin From Day One

At Hollister Ostomy Care, we believe peristomal skin deserves better.
Clinical evidence continue to empower everything we do.

The ADVOCATE clinical trial looked at difference in ostomy skin barriers
and their impact on costs of stoma care and occurrence of peristomal
skin complications (PSCs).

® 14% relative reduction in stoma-related cost of care with the
CeraPlus skin barrier

See the Evidence That Can Empower You.

>

CeraPlus skin barriers help CeraPlus skin barriers significantly
support healthy skin and help reduce the stoma-related cost
minimize ostomy burden right of care.!

from the start.!

Significantly more participants 15% fewer PSCs with the
were "very satisfied" with overall CeraPlus Skin Barrier.
barrier performance and itching

prevention.

Observed to be better at helping maintain o, X
intact skin.>® < g g
Observed to be better at managing TEWL.?3 /) X)
Observed to be better at protecting skin against >, X
damage from repeated barrier removal.?* - =

Start using the CeraPlus skin barrier from
day one to help ensure the healthy skin
your patients deserve.

~rd|
Contact your Hollister sales representative
today for details.

References:

1. Colwell J, Pittman J, Salvadelena G. A randomaized controlled trial detrmining variances in ostomy skin
conditions and the economic impact (ADVOCATE). Journal Wound Ostomy Continence Nurs. 2018;45(1):37-42

2. Nichols T, Houser T, Grove G. Comparing the skin stripping effects of three ostomy skin barriers infused with
ceramid, honey or aloe. Journal of Stomal Therapy Australia 2019; 39(2); 14-18

3. Grove G, Houser T, Sibbald G, Salvadalena G. Measuring epidermal effects of ostomy skin barriers. Skin Res
Technol. 2019;25:179-186. https://doi.org/10/111/srt/12630



Keeping peristomal skin

healthy is the inspiration

for all we do
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New Image

Two-Piece Pouching System
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New Image
Two-Piece Pouching System

Why choose a two-piece
pouching system?

With a two-piece pouching system,

the skin barrier and pouch are separate
and connect together with a plastic ring,
or flange. Here are a few reasons why
you might want to use a two-piece
pouching system:

* You may want to change your pouch
more often than your skin barrier

* You may want to alternate between
different pouch styles. For example,
you might want to wear a smaller pouch
during exercise or in the shower, and a
larger pouch at night

* You may find it easier to center your
skin barrier over your stoma using a
two-piece system



Integrated Floating Flange

e Audible clicks signal a secure attachment
e Discrest low profile attachment of pouch to barrier

CeraPlus Skin Barrier

The CeraPlus skin barrier with Remois technology™ is
infused with ceramide, the skin’s naturally occurring
protection against dryness. It is designed to maintain
adhesive properties, and features a ceramide-infused
formulation to help:

e Protect the skin’s natural moisture barrier

 Maintain good peristomal skin health

e Decrease transepidermal water loss (TEWL) from
damaged or eroded skin

*Remois technology is a technology of Alcare Co., Ltd.

New Image Pouches

e Waterproof, integrated AF300 filter is designed to allow
gas and air to escape, but keeps odor and output in the
pouch. Liquid cannot penetrate the filter, therefore not
requiring a protective sticker

e Choice of secure pouch closure options — clamp or
integrated closure

e ComfortWear panels provide enhanced discretion
and comfort

e Numerous pouch size options to meet individual
preferences

www.hollister.com Hollister Incorporated 27



New Image Two-Piece Pouching System

Color Matching System Flat Skin Barriers with Integrated Floating Flange
_Di ; £ == 1120x (CUT-TO-FIM) Box of 5
Two-Piece Pouching SVStems Q ° > CeraPlus (extended wear) Skin Barrier Ceramide
To help you select compatible New Image pouching system components, > With Tape Border
every box label is color-coded. HCPCS: A4409
1. Select the skin barrier flange size with the appropriate barrier stoma ?:“2‘;';"" .F'?“;’/Zfi:: F°’1s:‘;$a:2"" To
opening and note its color code. hheie il T3t amm
. . . . ) 11204 2-3/4" (7 2-1/4" (57
2. Select a suitable pouch with the desired features in the matching color. 0 2 B0 A (57 o)
Flange Sizes: @7 1510x (CUT-TO-AIM) Box of 5
g O; ‘ » CeraPlus (extended wear) Skin Barrier Ceramide
o » Without Tape Border
1-3/4" (44 mm) HCPCS for 15102, 15103: A4409
HCPCS for 15104: A4410
Stock No Flange Size For Stomas Up To
; 15102 @ 1-3/4" (44 mm 1-1/4" (32 mm
- 2-1/4" (57 mm) 15103 & 214 257 mm§ 1-3/4" 544 mm;
15104 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
o/ < 1460x (CUT-TO-FIT) Box of 5
- 2-3/4" (70 mm) Q > Flextend (extended wear) Skin Barrier

» With Tape Border
HCPCS for 14602, 14603 & 14604: A4409

4" (102 mm) HCPCS for 14606: A4410
Stock No Flange Size For Stomas Up To
14602 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
o S, L
. i 14604 2-3/4" -1/4"
NQTE. All stock numbers s_had_ed in gray throughout 10 4 (02 21 B mm
this catalog denote ceramide-infused products.
& 1560x (CUT-TO-FI B f5
Look for the convex and soft convex symbols: B & - xconced wean Skin Barer ox o
) > Without Tape Border
< convex CONVEX HCPCS for 15602 & 15603: A4409
HCPCS for 15604: A4410
Stock No Flange Size For Stomas Up To
15602 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
15603 @& 2-1/4" (57 mm) 1-3/4" (44 mm)
15604 @& 2-3/4" (70 mm) 2-1/4" (57 mm)

) 1420x (CUT-TO-FIT) Box of 5
o > FlexWear (standard wear) Skin Barrier
S With Tape Border

HCPCS for 14202, 14203 & 14204: A4414
HCPCS for 14206: A4415

Stock No Flange Size For Stomas Up To
14202 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
14203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
14204 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
14206 4" (102 mm) 3-1/2" (89 mm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.
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New Image Two-Piece Pouching System

Flat Skin Barriers with Integrated Floating Flange (continued) Flat Skin Barriers with Integrated Floating Flange (continued)

1520x (CUT-TO-FIT) Box of 5 7 1430x (PRE-SIZED) Box of 5
g > FlexWear (standard wear) Skin Barrier @ > FlexWear (standard wear) Skin Barrier

» Without Tape Border » With Tape Border

HCPCS for 15202 & 15203: A4414 HCPCS: Ad4414
HCPCS for 15204: A4415 Stock No Flange Size Barrier Opening
Stock No Flange Size For Stomas Up To 14301 & 1-3/4" (44 mm) 5/8" (16 mm)
15202 @& 1-3/4" (44 mm) 1-1/4" (32 mm) 14302 @ 1-3/4" (44 mm) 3/4" (19 mm)
15203 @ 2-1/4" (57 mm) 1-3/4" (44 mm) 14303 @ 1-3/4" (44 mm) 7/8" (22 mm)
15204 @ 2-3/4" (70 mm) 2-1/4" (57 mm) 14304 @ 1-3/4" (44 mm) 1" (25 mm)
14305 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
14306 : 1-3/4" (44 mm) 1-1/4" (32 mm)
. 14307 2-1/4" (57 mm) 1-3/8" (35 mm)
(7)) 1470x PRESIZED) o Box of 5 14308 & 2-1/4" (57 ) 1-1/2" (38 mm)
./ > Flextend (extended wear) Skin Barrier 14309 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
B @& ., \ith Tape Border
HCPCS: A4409 S0 2 1640x (PRE-SIZED) Box of 5
Stock No Flange Size Barrier Opening @/ > FlexWear (standard wear) Skin Barrier
14701 : 1-3/4" (44 mm) 5/8" (16 mm) Y Y » Without Tape Border
14702 1-3/4" (44 mm) 3/4" (19 mm)
14703 : 1- 3;4 (44 mm) 7/8" (22 mm) HCPCS: Ad414
14704 1-3/4" (44 mm) 1" (25 mm) ; ; i
14705 & 134 (44 mm) 1-1/8" (29 mm) Stock No Flange"S|ze Barrier Opening
14706 @ 1-3/4" (44 mm) 1-1/4" (32 mm) 16402 @ 1-3/4" (44 mm) 3/4" (19 mm)
14707 @& 2-1/4" (57 mm) 1-3/8" (35 mm) 16403 @ 1-3/4" (44 mm) 7/8" (22 mm)
14708 @ 2-1/4" (57 mm) 1-1/2" (38 mm) 16404 & 1-3/4" (44 mm) 1" (25 mm)
14709 @ 2-1/4" (57 mm) 1-3/4" (44 mm) 16405 @ 1-3/4" (44 mm) 1-1/8" (29 mm)
16406 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
16407 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
S P2 1610x PR SZED) Box of 5 16408 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
4 > Flextend (extended wear) Skin Barrier
S REET» without Tape Border . 1410x (SHAPE-TO-FIT) Box of 5
HCPCS: A4409 @ > FormaFlex (extended wear) Skin Barrier
Stock No Flange Size Barrier Opening > With Tape Border
16101 : 1-3/4" (44 mm) 5/8" (16 mm) HCPCS: A4409
16102 1-3/4" (44 mm) 3/4" (19 mm) ;
16103 & 13/ (14 mm) 718" (22 mm) Stock No Flange "S|ze . For S:omas Up To
16104 @& 1-3/4" (44 mm) 1" (25 mm) 14102 @ 1-3/4" (44 mm) 1/2°1-1/4" (13-32 mm)
16105 &> 1-3/4" (44 mm) 1-1/8" (29 mm) 14103 @ 2-1/4" (57 mm) 5/8"-1-11/16" (16-43 mm)
16106 & 1-3/4" (44 mm) 1-1/4" (32 mm) 14104 @ 2-3/4" (70 mm) 5/8"-2-1/4" (16-57 mm)
16107 @ 2-1/4" (57 mm) 1-3/8" (35 mm)
16108 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
7 DID YOU KNOW...
A True Original
? DID YOU KNOW... The Hollister integrated floating flange—as featured

in the New Image two-piece pouching system—offers
optimal flexibility and security for you and your

patients. The first of its kind, this integrated
e Each box of New Image pouches includes one disposal bag per pouch floating flange helps relieve pressure on
for discreet disposal the tender postoperative or soft abdomen
e Cutting guides are provided for all cut-to-fit barriers while offering an easy-to-use, low-profile
e |t is not recommended that you cut a pre-sized skin barrier solution patients can continue to use after
e [t is not recommended to cut past the stop line on a cut-to-fit barrier they transition home. Included in all flat and
o Available on www.hollister.com convex New Image skin barriers.
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New Image Two-Piece Pouching System

Convex Skin Barriers with Integrated Floating Flange

1140x (CUT-TO-FIT)

\I ;

» With Tape Border

Box of 5

» CeraPlus (extended wear) Skin Barrier C
CONVEX

HCPCS: A4407 Ceramide
Stock No Flange Size For Stomas Up To
11402 @& 1-3/4" (44 mm) 1" (25 mm)
11403 @& 2-1/4" (57 mm) 1-1/2" (38 mm)
11404 @& 2-3/4" (70 mm) 2" (51 mm)

Box of 5

@ 1530x (CUT-TO-FIT)
> CeraPlus (extended wear) Skin Barrier C
i CONVEX

» Without Tape Border

HCPCS for 15302, 15303: A4407 Ceramide
HCPCS for 15304: A4408
Stock No Flange Size For Stomas Up To
15302 & 1-3/4" (44 mm) 1" (25 mm)
15303 @& 2-1/4" (57 mm) 1-1/2" (38 mm)
15304 @ 2-3/4" (70 mm) 2" (51 mm)

Box of 5

@ ° 1480x (CUT-TO-FIT)
/ > Flextend (extended wear) Skin Barrier
\ oxtend ) < convex

> With Tape Border
HCPCS: A4407

Stock No Flange Size For Stomas Up To
14802 @ 1-3/4" (44 mm) 1" (25 mm)
14803 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
14804 @ 2-3/4" (70 mm) 2" (51 mm)

Box of 5

@ 1580x (CUT-TO-FIT)
> Flextend (extended wear) Skin Barrier (
CONVEX

» Without Tape Border

HCPCS for 15802 & 15803: A4407
HCPCS for 15804: A4408

Stock No Flange Size For Stomas Up To
15802 @& 1-3/4" (44 mm) 1" (25 mm)
15803 @& 2-1/4" (57 mm) 1-1/2" (38 mm)
15804 @ 2-3/4" (70 mm) 2" (51 mm)

Convex Skin Barriers with Integrated Floating Flange (continued)

Design Recommended replacement for 1440x series below

4| ° 1340x (CUT-TO-FIT) Box of 5
Q‘\ D > FlexWear (standard wear) Skin Barrier
4 > With Tape Border CCONVEX

Upgraded Design Features:
> Flexible Release Liner
» Tapered Barrier Edges

HCPCS: A4373

Stock No Flange Size For Stomas Up To
13402 @ 1-3/4" (44 mm) 1" (25 mm)
13403 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
13404 @ 2-3/4" (70 mm) 2" (51 mm)

Original Design
1440x (CUT-TO-FIT) Box of 5

> FlexWear (standard wear) Skin Barrier -
> With Tape Border < convex

HCPCS: A4373

Stock No Flange Size For Stomas Up To
14402 @ 1-3/4" (44 mm) 1" (25 mm)
14403 @ 2-1/4" (57 mm) 1-1/2" (38 mm)
14404 @& 2-3/4" (70 mm) 2" (51 mm)

1540x (CUT-TO-FIT) Box of 5

@ > FlexWear (standard wear) Skin Barrier
» Without Tape Border C CONVEX
HCPCS: A4373

Stock No Flange Size For Stomas Up To
15402 @& 1-3/4" (44 mm) 1" (25 mm)
15403 @& 2-1/4" (57 mm) 1-1/2" (38 mm)
15404 @ 2-3/4" (70 mm) 2" (51 mm)

2 DID YOU KNOW...

The CeraPlus skin barrier is infused with ceramide

e Ceramide is a natural
component of the
human skin

o Ceramide links the
cells of the stratum
corneum together to
form a waterproof,
protective barrier

 Ceramide helps
prevent water loss
that can lead to skin
damage and dryness

2  DID YOU KNOW...

Select New Image two-piece pouching systems

feature two important product upgrades:

e Lock 'n Roll microseal closure with ribbed strips to facilitate ease of use,
and transparent flap for increased security

 Upgraded skin barrier design to help increase comfort and help improve
ease of use:

- Flexible release liner covers both the skin barrier and the tape border to
help provide improved ease of use

- Tapered barrier edges to help provide increased comfort
- No change in skin barrier application
- Same HCPCS code

For a complete list of Hollister products, refer to the comprehensive

Hollister product catalog online at www.hollister.com.



New Image Two-Piece Pouching System

Convex Skin Barriers with Integrated Floating Flange (continued) Convex Skin Barriers with Integrated Floating Flange (continued)

7;’»\ e 1150x (PRE-SIZED) Box of 5 ° . 1590x (PRE-SIZED) Box of 5
‘ ) > CeraPlus (extended wear) Skin Barrier > Flextend (extended wear) Skin Barrier
@ 4 + With Tape Border < comvex < convex

» Without Tape Border

HCPCS: A4407 Ceramide HCPCS: A4407
Stock No Flange Size Barrier Opening Stock No Flange Size Barrier Opening
11503 & 1-3/4" (44 mm) 7/8" (22 mm) 15903 & 1-3/4" (44 mm) 7/8" (22 mm)
11504 & 1-3/4" (44 mm) 1" (25 mm) 15904 & 1-3/4" (44 mm) 1" (25 mm)
11505 @ 2-1/4" (57 mm) 1-1/8" (29 mm) 15905 @ 2-1/4" (57 mm) 1-1/8" (29 mm)
11506 &> 2-1/4" (57 mm) 1-1/4" (32 mm) 15906 & 2-1/4" (57 mm) 1-1/4" (32 mm)
Upgraded Design Recommended replacement for 149xx series below Upgraded Design Recommended replacement for 1450x series below
= = 1350x (PRE-SIZED) Box of 5
N 139xX (PRE-SIZED) Box of 5 @) N . .
( ) . . ) FlexWear (standard wear) Skin Barrier
A e > Flextend (extended wear) Skin Barrier < : CONVEX
- » With Tape Border < convex » With Tape Border <

Upgraded Design Features:
» Flexible Release Liner
» Tapered Barrier Edge

HCPCS: A4373

Upgraded Design Features:
> Flexible Release Liner
» Tapered Barrier Edge

HCPCS: A4407

Stock No Flange Size Barrier Opening Stock No Flange "S|ze BarrlerHOpenlng
13901 & 134" (44 mm 5/8" (16 mm 13008 = e 8. g
1388% : ]gﬁ (ﬁ mm %8 (122 mm 13505 & 2-1/4" (57 mm) 1-1/8" (29 mm)
» (44 mm (22 mm 13506 & 2-1/4" (57 mm) 1-1/4" (32 mm)
13904 & 1-3/4" (44 mm 1" (25 mm
13905 & 2-1/4" (57 mm 1-1/8" (29 mm
13906 @& 2-1/4" (57 mm 1-1/4" (32 mm = :
13907 @ 2-1/4" (57 mm 1-3/8" (35 mm Original Design
13908 @ 2-1/4" (57 mm 1-1/2" (38 mm
19909 b < o gg mm e m mm 1450x (PRE-SIZED) Box of 5
@ - mm ; mm, > FlexWear (standard wear) Skin Barrier
13911 & 2-3/4" (70 2" (51
(70 mm o1 mm > With Tape Border << convex

girisl et gl Stock No Flange Size Barrier Opening

149xX (PRE-SIZED) Box of 5 14503 3 1-3/4" (44 mm) 7/8" (22 mm)
» Flextend (extended wear) Skin Barrier G 1228‘51 P 12:%2.. Eg;‘ mmg 11 /23.. gg mg
» With Tape Border CONVEX 14506 & 2-1/4" (57 mm) 14/4" (32 mm)
HCPCS: A4407
Stock No Flange Size Barrier Opening 1550x (PRE-SIZED) Box of 5
14901 : 1- 3;4" 244 mmg 5;8” E16 mm) @ . > FlexWear (standard wear) Skin Barrier CCONVEX
14902 1-3/4" (44 mm) 3/4" (19 mm
14903 @ 1-3/4" (44 mm) 7/8" (22 mm > Without Tape Border
14904 @ 1-3/4" (44 mm) 1" (25 mm) HCPCS: A4373
14905 & 2-1/4" (57 mm) 1-1/8" (29 mm ; . )
14906 @ 2-1/4" (57 mm) 1-1/4" (32 mm Stock No Flange Size Barrier Opening
14907 @ 2-1/4" (57 mm) 1-3/8" (35 mm 15503 @ 1-3/4" (44 mm) 7/8" (22 mm)
14908 @ 2-1/4" (57 mm) 1-1/2" (38 mm 15504 @ 1-3/4" (44 mm) 1" (25 mm)
14909 @ 2-3/4" (70 mm) 1-5/8" (41 mm 15505 @ 2-1/4" (57 mm) 1-1/8" (29 mm)
14910 @ 2-3/4" (70 mm) 1-3/4" (44 mm 15506 @ 2-1/4" (57 mm) 1-1/4" (32 mm)
14911 @ 2-3/4" (70 mm) 2" (51 mm)

2 DID YOU KNOW...

Convex Skin Barrier Options

The New Image two-piece pouching system delivers several skin barrier
options to fit a variety of patient needs. Built-in convexity options provide
extra security for recessed and flush stomas, and peristomal skin with
soft muscle tone. Convex skin barriers are also available with and
without tape.
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New Image Two-Piece Pouching System

Soft Convex Skin Barriers with Integrated Floating Flange

Q £ 1170x (CUT-TO-FM) Box of 5
y/e > CeraPlus (extended wear) Skin Barrier SOFT
mdl Soft Convex CCONVEX

@ > With Tape Border T
HCPCS: A4407

Stock No Flange Size For Stomas Up To

11702 @ 1-3/4" (44 mm) 1" (25 mm)

11703 @ 2-1/4" (57 mm) 1-1/2" (38 mm)

11704 @& 2-3/4" (70 mm) 2" (51 mm)

£~ 1190x (PRE-SIZED) Box of 5

w > CeraPlus (extended wear) Skin Barrier ~ SOFT

~ » Soft Convex CONVEX

@ > With Tape Border Ceramide
HCPCS: A4407

Stock No Flange Size For Stomas Up To

11903 @& 1-3/4" (44 mm) 7/8" (22 mm)

11904 @& 1-3/4" (44 mm) 1" (25 mm)

11905 @& 2-1/4" (57 mm) 1-1/8" (29mm)

11906 @& 2-1/4" (57 mm) 1-1/4" (32 mm)

Two-Piece Soft Convex [F% &

CeraPlus skin barrier Ly ﬂ'iﬁ
. o [m] vt

CeraPlus skin barrier now comes in two-piece

soft convexity designed to achieve a better fit to D Scan Me

help minimize leakage and a formulation to support
healthy skin from Day One.

Watch the video to learn
more about the product.

DID YOU KNOW...
4 Educa@
Get FIT

with the digital ostomy skin barrier
Fit Indicator Tool

Developed with an international panel of experienced stoma care nurses,
a new tool from Hollister Education has been designed to provide a
simple patient assessment methodology to determine the need for a

flat or convex barrier.

Ready to get started? Visit www.hollister.com/education or download
the app by searching “Hollister Education” on iTunes or Google Play.

Choose the skin barrier that

delivers Fit and Formulation to help ' \

The Two-Piece Soft Convex
CeraPlus™ skin barrier with
Remois Technology* has a

soft and flexible design to help
minimize leakage with the added
benefit of ceramide to help keep
skin healthy. Ceramide is a natural
component of human skin that
helps prevent water loss that can
lead to skin dryness and damage.

See pages
16 and 36
for more detail.

Order a free
sample today.

Call your local Hollister
rep or visit

www.hollister.com

Prior to use, be sure to read the Instructions for Use for information regarding Intended
Use, Contraindications, Warnings, Precautions and Instructions for Use. The Hollister logo,
CeraPlus and “Healthy skin. Positive outcomes.” are trademarks of Hollister Incorporated
All other trademarks and copyrights are the property of their respective owners

© 2020 Hollister Incorporated.

“*Remois is a technology
of Alcare Co., Ltd.

Ostomy Care

Healthy skin. Positive outcomes.

% Hollister:



New Image Two-Piece Pouching System

Drainable Pouches

Drainable Pouches (continued)

1818x/1819x Box of 10 = 1814x/1816x Box of 10
> Drainable Pouch Q > Drainable Pouch Includes 1 clamp
» With Integrated AF300 Filter 4 > With Integrated AF300 Filter
> Lock 'n Rol Microseal Closure > Clamp Closure
» With Belt Tabs > With Belt Tabs
» With ComfortWear Panels . » With ComfortWear Panels
- Transparent — Body Side Only = - Transparent — Body Side Only
- Beige — Both Sides - Beige — Both Sides
HCPCS: A4425 HCPCS: A4425
Transparent Beige Flange Pouch Transparent Beige Flange Pouch
Stook No Stock No Size Length Stock No Stock No Size Length
18192 18162 @& 1-3/4" (44 mm 12" (30 cm 18162 18142 @ 1-3/4" (44 mm) 12" (30¢cm)
18193 18183 @ 2-1/4" E57 mm; 12" 530 cm§ 18163 18143 @ 2-1/4" (57 mm) 12" (30 cm)
18194 18184 @ 2-3/4" (70 mm) 12" (30 cm) 18164 18144 @ 2-3/4" (70 mm) 12" (30 cm)
e 1828x/1829x Box of 20 1810x/1812x/1817x Box of 10
3 » Drainable Mini-Pouch » Drainable Pouch Includes 1 clamp
B » With Integrated AF300 Filter > Without Integrated Filter
> Lock 'n Roll Microseal Closure > Clamp Closure
> With Belt Tabs - > With Belt Tabs
> With ComfortiVear Panels = > With ComfortiWear Panels
- Transparent — Body Side Only - Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides - Beige — Both Sides
HCPCS: A4425 HCPCS: A5063
i Ultra-Clear Transparent  Beige Flange Pouch
g'tﬂ'éipﬁ;e"t st?;iffwo Flsai:ge L';?,lg;n StockNo  Stock No  Stock No Size Length
18292 18282 & 1-3/4" (44 mm) 7" (18 cm) 18172 18102 18122 @ 1-3/4" (44 mm) 12" (30 cm)
B mm  @hmEm i B e W Shbwm pew
-3/4" " - mm, cm
18294 18284 @ 2-3/4" (70 mm) 7" (18 cm) LS 310 312 Lyomm 12 g0
: 1811x/1813x/1800x Box of 10 —
g » Drainable Pouch 1820x N Box of 10
» Without Integrated Filter > Drainable Mini-Pouch Includes 1 clamp
1 / > Lock 'n Roll Microseal Closure Y, > Without Inteqrated Filter
= > With Belt Tabs = g %ﬁhmg Cﬁ'OTSL;)re
» With ComfortWear Panels = > Wwith Bett 1abs .
- Transparent and Ultra-Clear — Body Side Only > With ComfortWear Panels — Both Sides
- Beige — Both Sides HCPCS: A5063
. Beige Flange Pouch
Ultra-Cl T HCPtCS. I;5963 Fi Pouch Stock No Size Length
ra-Glear Iransparen eige ange 'ouci
; 18202 @ 1-3/4" (44 mm) 9" (23 cm)
Stock No Stock No  Stock No Size Length 18203 & 27/ (57 mm) o (23 om)
18002 18132 18112 @ 1-3/4"@4mm) 12" (30cm) 18204 & 2-3/4" (70 mm) 9" (23 cm)
18003 18133 18113 @ 2-1/4" (57 mm) 12" (30 cm)
18004 18134 18114 @& 2-3/4" (70 mm) 12" (30 cm)
18006 — — 4"(102mm) 12" (30 cm)

DID YOU KNOW...

i
:
_;
|

o All New Image pouches are made up of multiple layers of odor-barrier film

* New Image barriers must be used with New Image pouches and should not ;
be interchanged with other pouching systems i
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New Image Two-Piece Pouching System

High Output Drainable Pouches

1801x

> Drainable Pouch

» Without Integrated Filter
> Soft Drain Tap

> With Belt Tabs

» With ComfortiWear Panel — Body Side Only

Box of 10

» No adapter needed to connect to bedside collector

HCPCS: A4412

Ultra-Clear Flange Pouch
Stock No Size Length
18012 @ 1-3/4" (44 mm) 12" (30 cm)
18013 @ 2-1/4" (57 mm) 12" (30 cm)
18014 @ - 3/4 (70 mm) 12" (30 cm)
18016 4" (102 mm) 12" (30 cm)
Closed Pouches
“‘ 1836x/1837x Box of 60
» Closed Pouch
f > With Integrated AF300 Filter

o > With Belt Tabs

» With ComfortWear Panels

- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4419
Transparent Beige Flange Pouch
Stock No Stock No Size Length
18362 18372 @ - 3/4 ' (44 mm) 9" (23 cm)
18363 18373 @ 2-1/4" (57 mm) 9" (23 cm)
18364 18374 @& 23 70 mm) 9" (23 cm)

1832x Box of 30

> Closed Pouch
1 > With Integrated AF300 Filter
- > With Belt Tabs

» With QuietWear Pouch Material — Both Sides

HCPCS: A4419
Beige Flange Pouch
Stock No Size Length
18322 @ 1-3/4" (44 mm) 9" (23 cm)
18323 @ 2-1/4" (57 mm) 9" (23 cm)
18324 @ 2-3/4" (70 mm) 9" (23 cm)

Closed Pouches (continued)

1838x/1839x Box of 60
> Closed Mini-Pouch
> With Integrated AF300 Filter
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4419

Transparent Beige Flange Pouch
Stock No Stock No Size Length
18382 18392 @ 1-3/4" (44 mm) 7" (18 cm)
18383 18393 @ 2-1/4" (57 mm) 7" (18 cm)
18384 18394 @& 2-3/4" (70 mm) 7" (18 cm)
1833x Box of 30
1873x Box of 60
— > Closed Pouch
- » Without Integrated Filter
» With Belt Tabs
» With QuietWear Pouch Material — Both Sides
HCPCS: A5054
Beige Beige
Stock No Stock No Flange Pouch
Box of 30 Box of 60 Size Length
18332 18732 @ 1-3/4" (44 mm) 9" (23 cm)
18333 18733 @ 2-1/4" (57 mm) 9" (23 cm)
18334 18734 @& 2-3/4" (70 mm) 9" (23 cm)
i, 1835x Box of 30
-~ 1875x Box of 60

=

> Closed Mini-Pouch

» Without Integrated Filter

> With Belt Tabs

» With ComfortiWear Panels — Both Sides

HCPCS: A5054

Beige Beige

Stock No Stock No Flange Pouch
Box of 30 Box of 60 Size Length
18352 18752 @ 1-3/4" (44 mm) 7" (18 cm)
18353 18753 @ 2-1/4" (57 mm) 7" (18 cm)
18354 — @ 2-3/4" (70 mm) 7" (18 cm)

Products for Colostomy Irrigations - see page 86-87
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New Image Two-Piece Pouching System

Urostomy Pouches

Upgraded Design

ded replacement for 1840x/1841x/1842xx

series below

1890x/1891x/1892x

» Urostomy Pouch

» Anti-Reflux Valve

» With Belt Tabs

» With ComfortWear Panels

Box of 10
Includes 2 adapters

Non Sterile Kits — Drainable

1960x
Colostomy/lleostomy Kit includes:

> (1) 1120x CeraPlus (extended wear)

Skin Barrier with Tape Border

Box of 5
Ceramide

> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear

Pouch Film
> Single-Use Package

> With ComfortWear Panels-Body Side Only

- Transparent and Ultra-Clear — Body Side Only HCPCS: A5063 + Ad414
- Beige — Both Sides Ultra-Clear Flange
Upgraded Design Features: Stock No Size For Stomas Up To
» Multi-Chamber Design 19602 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
> Softer, Streamlined Tap 19603 & 2-1/4" (57 mm) 1-3/4" (44 mm)
» Drain Valve Indicator 19604 @ 2-3/4 (70 mm) 2-1/4" (57 mm)
HCPCS: A4432
Ultra-Clear Transparent  Beige Flange Pouch . 1980x - Box of 5
StockNo  StockNo  Stock No Size Length Colostomy/lleostomy Kit includes: Ceramide
18922 18902 18912 @D 1-3/4"@4mm) 9" (23cm) J > (1) 1120x CoraPlus (extended wear)
18923 18903 18913 @ 2-1/4" (57 mm) 9" (23 om) 4 Skin Barrier with Tape Border
18924 18904 18914 @ 2-3/4" (70 mm) 9" (23 cm) > (1) 1817x (Clamp Closure) Ultra-Clear Pouch Film
> Single-Use Package
> With ComfortWear Panels-Body Side Only
> Clamp Included
1840x/1841x/1842x Box of 10 HCPCS: A5063 + A4409
> Urostomy Pouch Includes 1 adapter Ultra-Clear Flange
</ > Anti-Reflux Valve Stock No Size For Stomas Up To
> With Belt Tabs 19802 & 1-3/4" (44 mm) 1-1/4" (32 mm)
» With ComfortWear Panels 19803 D 2-1/4" (57 mm) 1-3/4" (44 mm)
- Transparent and Ultra-Clear — Body Side Only 19804 & 2-3/4" (70 mm) 2-1/4" (57 mm)
- Beige — Both Sides 1900x Box of 5
HCPCS: A4432 Colostomy/lleostomy Kit includes:
Ultra-Clear Transparent  Beige Flange Pouch s > (1) 1420x FlexiWear (standard wear)
Stock No Stock No  Stock No Size Length W 4 \ Skin Barrier with Tape Border
18422 18402 18412 @ 1-3/4" (44 mm) 9" (23 cm) \ . > (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear Pouch Film
18423 18403 18413 @ 2-1/4" (57 mm) 9" (23 cm) > (1) 7767 Loop Ostomy Bridge (in 19006 only)
— 18404 18414 @ 2-3/4" (70 mm) 9" (23 cm) > Single-Use Package
> With ComfortWear Panels-Body Side Only
HCPCS for 19002, 19003 & 19004: A5063 + A4414
HCPCS for 19006: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19002 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19003 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19004 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
19006 4" (102 mm) 3-1/2" (89 mm)
1910x Box of 5

-~ Colostomy/lleostomy Kit includes:
y / © > (1) 1420x Flex\Vear (standard wear)

DID YOU KNOW N _— Skin Barrier with Tape Border

> (1) 1817x (Clamp Closure) Ultra-Clear Pouch Film

> (1) 7767 Loop Ostomy Bridge (in 19106 only)
> Single-Use Package
> With ComfortWear Panels-Body Side Only
e The upgraded 1890x urostomy pouch series comes with two adaptors.
The original 1840x urostomy pouch series only comes with one
e Please see page 83 for the Hollister Bedside Drainage Collection

HCPCS for 19102, 19103 & 19104: A5063 + A4414
HCPCS for 19106: A5063 + A4415

Ultra-Clear Flange
System with Anti-Reflux Valve or visit www.hollister.com for all Hollister Stock No Size For Stomas Up To
Leg Bag Systems i 19102 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
i 19103 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19104 @ 2-3/4" (70 mm) 2-1/4" (57 mm)
19106 4" (102 mm) 3-1/2" (89 mm)
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New Image Two-Piece Pouching System

Non Sterile Kits — Drainable (continued)
a 1930x
= Colostomy/lleostomy Kit includes:
> (1) 1410x FormaFlex (extended wear)
e Skin Barrier with Tape Border
> (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
> (1) 1842x with ComfortWear Panels
» Single-Use Package

HCPCS: A5063 + A4409

Box of 5

Ultra-Clear Flange

Stock No Size For Stomas Up To
19303 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19304 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

Non Sterile Kits — Urostomy

( > 1990x
Urostomy Kit includes:

1) 1120x CeraPlus (extended wear)
Sk|n Barrier with Tape Border

Box of 5
Ceramide

; > (1) 1892x with ComfortWear Panels (Ultra-Clear Pouch Film)

> (1) 7331 Urostomy Drain Tube Adapter
> Single-Use Package
» With Comforti/ear Panels-Body Side Only

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19902 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19903 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19904 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

vV 1920x Box of 5
i
L S~

Urostomy Kit includes:
> (1) 1460x Flextend (extended wear)

Xy
\'

. o Skin Barrier with Tape Border
> (1) 1842x with Comfortwear Panels-Body Side Panels
(Ultra-Clear Pouch Film)

> (1) 7331 Urostomy Drain Tube Adapter

» Single-Use Package

HCPCS: A4432 + A4409
Ultra-Clear Flange
Stock No Size For Stomas Up To
19202 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19203 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19204 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

@ 1940x Box of 5

; Urostomy Kit includes:
i;\*f > (1) 1410x FormaFlex (extended wear)

e

L Skin Barrier with Tape Border
> (1) 1842x with Comfortwear Panels-Body Side Only
(Ultra-Clear Pouch Film)
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19402 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19403 @ 2-1/4" (57 mm) 1-11/16 (43mm)

Sterile Kits — Drainable

1905x Box of 5
Colostomy/lleostomy Kit includes:
> (1) 1420x FlexWear (standard wear)

Skin Barrier with Tape Border

A&, > (1)1800x (Lack 'n Roll Microseal Closure) Ultra-Clear Pouch
. Film with Comfortwear Panels
> (1) 7767 Loop Ostomy Bridge (in 19056 only)
» Single-Use Package
HCPCS for 19052, 19053 & 19054: A5063 + A4414
HCPCS for 19056: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19052 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19053 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19054 @& 2-3/4" (70 mm) 2-1/4" (57 mm)
19056 4" (102 mm) 3-1/2" (89 mm)
1915x Box of 5
Colostomy/lleostomy Kit includes: 1 clamp per kit
> (1) 1420x FlexWear (standard wear)
S Skin Barrier with Tape Border
- (1) 1817x (Clamp Closure) Ultra-Clear with
— Comfortwear Panels
> (1) 7767 Loop Ostomy Bridge (in 19156 only)
» Single-Use Package
HCPCS for 19152, 19153 & 19154: A5063 + Ad4414
HCPCS for 19156: A5063 + A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19152 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19153 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19154 @ - 3/4 (70 mm) 2-1/4" (57 mm)
19156 4" (102 mm) 3-1/2" (89 mm)
1935x Box of 5
Colostomy/lleostomy Kit includes:
> (1) 1520x FlexWear (standard wear)
Nt Skin Barrier without Tape Border
ﬁ > (1) 1800x (Lock 'n Roll Microseal Closure) Ultra-Clear
y with Comfortwear Panels
» Single-Use Package
HCPCS for 19353: A5063 & A4414
HCPCS for 19353: A5063 & A4415
Ultra-Clear Flange
Stock No Size For Stomas Up To
19353 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19354 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.
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New Image Two-Piece Pouching System

Sterile Kits — Urostomy

& 1925x Box of 5
@ Urostomy Kit includes:

\_ﬁ:: > (1) 1460x Flextend (extended wear)
o Skin Barrier with Tape Border
> (1) 1842x with Comfortwear Panels
(Ultra-Clear Pouch Film)
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 + A4409

Ultra-Clear Flange

Stock No Size For Stomas Up To
19252 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
19253 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
19254 @ 2-3/4" (70 mm) 2-1/4" (57 mm)

@ @ 1950x Box of 5
Urostomy Kit includes:

\_‘** > (1) 15603 Flextend (extended wear)
& Skin Barrier without Tape Border
> (1) 1842x with ComfortiWear Panels
> (1) 18423 Ultra-Clear Pouch Film
> (1) 7331 Urostomy Drain Tube Adapter
» Single-Use Package

HCPCS: A4432 & A4409

Ultra-Clear Flange
Stock No Size For Stomas Up To
19503 @ 2-1/4" (57 mm) 1-3/4" (44 mm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.
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Premier
One-Piece Pouching System

Why choose a one-piece
pouching system?

With a one-piece pouching system, the
skin barrier and pouch are connected
and cannot be separated. Here are a few
reasons why you might want to use a
one-piece pouching system:

* You need a pouching system that
is flexible

* You may prefer a pouching system that
does not require putting pieces together

* You do not wish to change your pouch
more often than your skin barrier



Upgraded

Product Design

Select Premier One-Piece
Pouching Systems feature two
important product upgrades:

e [ock ’n Roll Microseal Closure with ribbed
strips to facilitate ease of use, and transparent
flap for increased security

e Upgraded skin barrier design to help increase
comfort and help improve ease of use:

- Flexible release liner covers both the skin barrier
and the tape border to help provide improved
ease of use

- Tapered barrier edges to help provide
increased comfort

- No change in skin barrier application
- Same HCPCS code

Look for the “i,i@‘,‘gﬁ d header above these

stock numbers.

Go to page 57-59, 61-62 and 66-70 for more detail.

For more information, contact your
Hollister Ostomy sales representative.

£ Hollister




Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers

Drainable Pouches with Flat Barriers (continued)

- 8901 (CUT-TO-FIT) Box of 10 8631/8651 (CUT-TO-FIT) Box of 10
= » Drainable Pouch Ceramide » Drainable Pouch Includes 1 clamp
» CeraPlus (extended wear) Skin Barrier > Flextend (extended wear) Skin Barrier
-y » With Tape Border / » With Tape Border
- » With Integrated AF300 Filter — » Without Integrated Filter
> Lock 'n Roll Microseal Closure = » Clamp Closure
» With Comfort\//ear Panels — Both Sides » With ComfortiWear Panels — Body Side Only
HCPCS: A5056 HCPCS: A4388
Beige w/Viewing Option Ultra-Clear Transparent
Stock No For Stomas Up To Pouch Length Stock No Stock No For Stomas Up To Pouch Length
8901 2-1/2" (64 mm) 12" (30 cm) 8651 8631 2-1/2" (64 mm) 12" (30 cm)
8931 (CUT-TO-FIT) Box of 10 28 8641 (CUT-TO-FIT) Box of 10
- > Drainable Pouch Ceramide \& > Drainable Mini-Pouch Includes 1 clamp
f > CeraPlus (extended wear) Skin Barrier ) > Flextend (extended wear) Skin Barrier
> With Tape Border » With Tape Border
» Without Integrated AF300 Filter . » Without Integrated Filter
» Lock 'n Roll Microseal Closure I » Clamp Closure
» With ComfortiWear Panels — Body Side Only » With ComfortiWear Panels — Body Side Only
HCPCS: A4388 HCPCS: A4388
Ultra-Clear Transparent
Stock No For Stomas Up To Pouch Length Stock No For Stomas Up To Pouch Length
8931 2-1/2" (64 mm) 12" (30 cm) 8641 2-1/2" (64 mm) 9" (23 cm)
=) 8331/8371 (CUT-TO-FIT) Box of 10 8081/8181/8381 (CUT-TO-FIT) Box of 10
' > Drainable Pouch - > Drainable Pouch
o > Flextend (extended wear) Skin Barrier > FlexWear (standard wear) Skin Barrier
» With Tape Border — » With Tape Border
» With Integrated AF300 Filter . » With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure > Lock 'n Roll Microseal Closure
» With ComfortWear Panels » With ComfortWear Panels
- Transparent — Bodly Side Only - Transparent — Bodly Side Only
- Beige with Viewing Option — Both Sides - Beige and Beige with Viewing Option — Both Sides
HCPCS: A5056 HCPCS: A4424
Transparent  Beige w/Viewing Option Transparent Beige Beige w/Viewing Option
Stock No Stock No For Stomas Up To Pouch Length Stock No Stock No Stock No For Stomas Up To  Pouch Length
8331 8371 2-1/2" (64 mm) 12" (30 cm) 8081 8181 8381 2-1/2" (64 mm) 12" (30 cm)
8531/8551 (CUT-TO-FIT) Box of 10
ol » Drainable Pouch
53 / > Flextend (extended wear) Skin Barrier
» With Tape Border
= > Without Integrated Filter
> Lock 'n Roll Microseal Closure
> With Comforti/ear Panels
- Beige — Both Sides
- Ultra-Clear — Body Side Only
HCPCS: A4388
Ultra-Clear Beige
Stock No Stock No For Stomas Up To Pouch Length
8531 8551 2-1/2" (64 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

i\ 8031 (CUT-TO-FIT) Box of 10
’”~ ‘“'\ > Drainable Pouch
",“ - ;’ > FlexWear (standard wear) Skin Barrier
— » With Tape Border
» Without Integrated Filter
> Lock 'n Roll Microseal Closure
» With ComfortiWear Panels — Body Side Only
HCPCS: A5061
Ultra-Clear
Stock No For Stomas Up To Pouch Length
8031 2-1/2" (64 mm) 12" (30 cm)
== 8131 (CUT-TO-FIT) Box of 10
péer » Drainable Pouch Includes 1 clamp
> S > FlexWear (standard wear) Skin Barrier
A » With Tape Border
% > Without Integrated Filter
g » Clamp Closure
— » With ComfortiWear Panels — Body Side Only
HCPCS: A5061
Ultra-Clear
Stock No For Stomas Up To Pouch Length
8131 2-1/2" (64 mm) 12" (30 cm)
= 88300/88400 (CUT-TO-FIT) Box of 10
» Drainable Pouch
» SoftFlex (standard wear) Skin Barrier
- » Without Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4424
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
88400 88300 2-1/8" (55 mm) 12" (30 cm)
= 88800/88700 (CUT-TO-FIT) Box of 20
» Drainable Mini-Pouch
= » SoftFlex (standard wear) Skin Barrier
» Without Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4424
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
88800 88700 2-1/8" (55 mm) 7" (18 cm)

For a complete list of Hollister products, refer to the comprehensive

Hollister product catalog online at www.hollister.com.

Drainable Pouches with Flat Barriers (continued)

=]

88302/88402 (OVAL CUT-TO-FIT) Box of 10
» Drainable Pouch
» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4424

Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
88402 88302 3"x2.5" (75 mm x 65 mm) 12" (30 cm)
88401 (CUT-TO-FIT) Box of 10
» Drainable Pouch
» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
» Without Integrated Filter
» Lock 'n Roll Microseal Closure
» With ComfortiWear Panels — Body Side Only
HCPCS: A5061
Ultra-Clear
Stock No For Stomas Up To Pouch Length
88401 2-1/2" (64 mm) 12" (30 cm)
88501 (CUT-TO-FIT) Box of 10

Ultra-Clear

» Drainable Pouch

» SoftFlex (standard wear) Skin Barrier
» Without Tape Border

» Without Integrated Filter

» Clamp Closure

» With ComfortiWear Panels — Body Side Only

HCPCS: A5061

Includes 1 clamp

Stock No For Stomas Up To Pouch Length
88501 2-1/2" (64 mm) 12" (30 cm)
89xX (PRE-SIZED) Box of 10
S =9 » Drainable Pouch rami
» CeraPlus (extended wear) Skin Barrier L
—y » With Tape Border
- > With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels — Both Sides
HCPCS: A5056
Beige w/Viewing Option
Stock No Barrier Opening Pouch Length
8925 1" (25 mm) 12" (30 cm)
8930 1-3/16" (30 mm) 12" (30 cm)
8935 1-3/8" (35 mm) 12" (30 cm)
8940 1-9/16" (40 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Flat Barriers (continued)

& 853x/855x (PRE-SIZED) Box of 10
i =| » Drainable Pouch
| = > Flextend (extended wear) Skin Barrier
%? » With Tape Border
= » Without Integrated Filter
= > Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides
HCPCS: A4388
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
— 8552 1" (25 mm) 12" (30 cm)
8538 8558 1-1/4" (32 mm) 12" (30 cm)
863X (PRE-SIZED) Box of 10
» Drainable Pouch Includes 1 clamp
/ > Flextend (extended wear) Skin Barrier
f » With Tape Border
— » Without Integrated Filter
_= > Clamp Closure
» With ComfortiWear Panels — Body Side Only
HCPCS: A4388
Transparent
Stock No Barrier Opening Pouch Length
8637 3/4" (19 mm) 12" (30 cm)
8632 1" (25 mm) 12" (30 cm)
8638 1-1/4" (32 mm) 12" (30 cm)
8633 1-1/2" (38 mm) 12" (30 cm)
8639 1-3/4" (44 mm) 12" (30 cm)
8634 2" (51 mm) 12" (30 cm)
8635 2-1/2" (64 mm) 12" (30 cm)
864X (PRE-SIZED) Box of 10
i » Drainable Mini-Pouch Includes 1 clamp
; / > Flextend (extended wear) Skin Barrier
e » With Tape Border
= » Without Integrated Filter
» Clamp Closure
» With ComfortiWear Panels — Both Sides
HCPCS: A4388
Beige
Stock No Barrier Opening Pouch Length
8647 3/4 " (19 mm) 9" (23 cm)
8642 " (25 mm) 9" (23 cm)
8648 1- 1/4" (32 mm) 9" (23 cm)
8643 1-1/2" (38 mm) 9" (23 cm)
8649 1-3/4" (44 mm) 9" (23 cm)
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Drainable Pouches with Flat Barriers (continued)

883xx/884xX (PRE-SIZED) Box of 10
» Drainable Pouch
» SoftFlex (standard wear) Skin Barrier
» Without Tape Border
» With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4424

Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
88425 88325 1" (25 mm) 12" (30 cm)
88430 88330 1-3/16" (30 mm) 12" (30 cm)
88435 88335 1-3/8" (35 mm) 12" (30 cm)
88440 88340 1-9/16" (40 mm) 12" (30 cm)

887xXx (PRE-SIZED) Box of 20

» Drainable Mini-Pouch

» SoftFlex (standard wear) Skin Barrier

» Without Tape Border

» With Integrated AF300 Filter

> Lock 'n Roll Microseal Closure

» With ComfortiWear Panels — Both Sides

HCPCS: A4424
Beige
Stock No Barrier Opening Pouch Length
88725 1" (25 mm) 7" (18 cm)
88730 1-3/16" (30 mm) 7" (18 cm)
88735 1-3/8" (35 mm) 7" (18 cm)
88740 1-9/16" (40 mm) 7" (18 cm)
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A flexible fit

L

made secure

Premier Soft Convex Pouching System
Designed to stay secure, no matter what shape
the body takes.

When it comes to finding the right solution for patients, fit comes
first. Comfort and ease-of-use are also essential to help ensure
positive outcomes—in the hospital and after patients

leave your care.

Hollister Ostomy presents Premier soft convex—a pouching
system that delivers both convex support and flexibility. The skin
barrier is designed to conform to the body, without compromising
fit. Belt tabs and a tape-bordered barrier help provide an extra
sense of security. And the new viewing option offers a convenient

way to help position the pouch and observe output.
- Look for the soft convex symbol €< Coﬁeg;

- Available in CeraPlus and Flextend (extended wear) skin
barrier formulations

% Ostomy Care



Premier One-Piece Pouching System

Drainable Pouches with Soft Convex Barriers

- 895xx (CUT-TO-FIT) Box of 5
== » Drainable Pouch -
> Soft Convex ( coﬁ%}
\ 4 > CeraPlus (extended wear) Skin Barrier i
. » With Tape Border LS
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels — Both Sides
HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8954 1" (25 mm) 12" (30 cm)
8958 1-1/2" (38 mm) 12" (30 cm)
89511 2-1/8" (55 mm) 12" (30 cm)
) 857xx/867xx (CUT-TO-FIT) Box of 5
<=7 > Drainable Pouch SOFT
> Soft Convex ~ CONVEX
- > Flextend (extended wear) Skin Barrier
- > With Tape Border
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels
- Ultra-Clear — Body Side Only
- Beige with Viewing Option — Both Sides
HCPCS: A5057
Ultra-Clear  Beige w/Viewing Option
Stock No Stock No For Stomas Up To Pouch Length
8574 8674 1" (13-25 mm) 12" (30 cm)
8578 8678 11/2" (13-38 mm) 12" (30 cm)
85711 86711 21/8" (13-55 mm) 12" (30 cm)
3 896X (PRE-SIZED) Box of 5
= » Drainable Pouch
> Soft Convex coﬁgg(
— > CeraPlus (extended wear) Skin Barrier P
- » With Tape Border Ceramide
> With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels — Both Sides
HCPCS: A5057
Beige w/Viewing Option
Stock No Opening Pouch Length
8960 3/4" (19 mm) 12" (30 cm)
8961 7/8" (22 mm) 12" (30 cm)
8962 1" (25 mm) 12" (30 cm)
8963 1-1/8" (29 mm) 12" (30 cm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.
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Premier One-Piece Pouching System

Drainable Pouches with Soft Convex Barriers (continued)

= 866X (PRE-SIZED) Box of 5
~ = > Drainable Pouch -~ SOFT
] » Soft Convex CONVEX

_— > Flextend (extended wear) Skin Barrier

» With Tape Border

> With Integrated AF300 Filter

» Lock 'n Roll Microseal Closure

> With Belt Tabs

» With ComfortiWear Panels — Both Sides

HCPCS: A5057

Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8661 7/8" (22 mm) 12" (30 cm)
8662 1" (25 mm) 12" (30 cm)
8663 1-1/8" (29 mm) 12" (30 cm)
8664 1-1/4" (32 mm) 12" (30 cm)
8665 1-1/2" (38 mm) 12" (30 cm)
8666 1-3/4" (44 mm) 12" (30 cm)
Drainable Pouches with Convex Barriers
: 891xx (CUT-TO-FIT) Box of 5
o > Drainable Pouch (
> CeraPlus (extended wear) Skin Barrier CONVEX
el » With Tape Border Ceramide
- > With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
» With Belt Tabs
» With ComfortWear Panels — Both Sides
HCPCS Code: A5057
Beige w/Viewing Option
Stock No For Stomas Up To Pouch Length
8914 1" (25 mm) 12" (30 cm)
8918 1-1/2" (38 mm) 12" (30 cm)
89111 2" (51 mm) 12" (30 cm)
898xx (CUT-TO-FIT) Box of 5

- » Drainable Pouch

4 > CeraPlus (extended wear) Skin Barrier CCONVEX
» With Tape Border Ceramide
» Without Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels — Body Side Only

HCPCS Code: A4390
Ultra-Clear

Stock No For Stomas Up To Pouch Length
8984 1" (25 mm) 12" (30 cm)
8988 1-1/2" (38 mm) 12" (30 cm)
89811 2" (51 mm) 12" (30 cm)

Drainable Pouches with Convex Barriers (continued)

esign Recommended replacement for 858xx series below

827xx/854x (CUT-TO-FIT) Box of 5
= » Drainable Pouch
— > Flextend (extended wear) Skin Barrier (CONVEX
[ » With Tape Border

- » With Integrated AF300 Filter
> With Belt Tabs
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige with Viewing Option — Both Sides
Upgraded Design Features:
» Lock 'n Roll Microseal Closure
with Ribbed Strips and Transparent Flap
» Flexible Release Liner
» Tapered Barrier Edges
HCPCS Code: A5057

Transparent  Beige w/Viewing Option

Stock No Stock No For Stomas Up To Pouch Length
8274 8544 1" (25 mm) 12" (30 cm)
8278 8548 1-1/2" (38 mm) 12" (30 cm)
82711 — 2" (51 mm) 12" (30 cm)

858xx (CUT-TO-FIT) Box of 5

» Drainable Pouch

> Flextend (extended wear) Skin Barrier < comve
» With Tape Border

» With Integrated AF300 Filter

> With Belt Tabs

> With ComfortWear Panels — Body Side Only

> Lock 'n Roll Closure

HCPCS Code: A5057

Transparent

Stock No For Stomas Up To Pouch Length
8584 1" (25 mm) 12" (30 cm)
8588 1-1/2" (38 mm) 12" (30 cm)
85811 2" (51 mm) 12" (30 cm)

DID YOU KNOW...

Select Premier one-piece pouching systems

feature two important product upgrades:

e Lock 'n Roll Microseal Closure with ribbed strips to facilitate ease of use,
and transparent flap for increased security

e Upgraded skin barrier design to help increase comfort and help improve
ease of use:

- Flexible release liner covers both the skin barrier and the tape border to
help provide improved ease of use

- Tapered barrier edges to help provide increased comfort
- No change in skin barrier application
- Same HCPCS code
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Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

Drainable Pouches with Convex Barriers (continued)

Upgraded Design Recommended replacement for 850x¢/852xx series below
824xx (CUT-TO-FIT) Box of 5

> Drainable Pouch
> Flextend (extended wear) Skin Barrier < convex
» With Tape Border
> Without Integrated Filter
> With Belt Tabs
> With Comfort\Wear Panels
- Transparent — Body Side Only

Upgraded Design Features:
> Lock 'n Roll Microseal Closure
with Ribbed Strips and Transparent Flap
> Flexible Release Liner
» Tapered Barrier Edges

HCPCS: A4390
Transparent
Stock No For Stomas Up To Pouch Length
8244 1" (25 mm) 12" (30 cm)
8248 1-1/2" (38 mm) 12" (30 cm)
82411 2" (51 mm) 12" (30 cm)

Original Design

850xx/852xx (CUT-TO-FIT) Box of 5

> Drainable Pouch C

> Flextend (extended wear) Skin Barrier CONVEX

» With Tape Border

» Without Integrated Filter

> With Belt Tabs

> With Comfort\Wear Panels

- Transparent — Body Side Only
- Beige — Both Sides

> Lock 'n Roll Closure

HCPCS: A4390
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
8524 8504 1" (25 mm) 12" (30 cm)
8528 8508 1-1/2" (38 mm) 12" (30 cm)
85211 85011 2" (51 mm) 12" (30 cm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.

Upgraded Design Recommended replacement for 862xx series below

8262xx (CUT-TO-FIT) Box of 5
> Drainable Pouch Includes 1 clamp
> Flextend (extended wear) Skin Barrier

> With Tape Border < comve
» Without Integrated Filter

» Clamp Closure

— > With Belt Tabs
> With ComfortWear Panels — Body Side Only
Upgraded Design Features:
» Flexible Release Liner
» Tapered Barrier Edges
HCPCS: A4390
Transparent
Stock No For Stomas Up To Pouch Length
82624 1" (25 mm) 12" (30 cm)
82628 1-1/2" (38 mm) 12" (30 cm)
826211 2" (51 mm) 12" (30 cm)

Original Design

862xx (CUT-TO-FIT) Box of 5
> Drainable Pouch Includes 1 clamp
> Flextend (extended wear) Skin Barrier

> With Tape Border < convex
> Without Integrated Filter

» Clamp Closure

> With Belt Tabs

> With ComfortWear Panels — Body Side Only

HCPCS: A4390

Transparent

Stock No For Stomas Up To Pouch Length
8624 1" (25 mm) 12" (30 cm)
8628 1-1/2" (38 mm) 12" (30 cm)
86211 2" (51 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

= 899X (PRE-SIZED) Box of 5
= | > Drainable Pouch

—3) > CeraPlus (extended wear) Skin Barrier < comvex
ey > With Tape Border Ceramide

— > With Integrated AF300 Filter
> Lock 'n Roll Microseal Closure
> With Belt Tabs
» With ComfortWear Panels — Both Sides

HCPCS: A5057

Beige w/Viewing Option

Stock No Barrier Opening Pouch Length
8990 3/4" (19 mm) 12 (30 cm)
8991 7/8 (22 mm) 2" (30 cm)
8992 1" (25 mm) 2" (30 cm)
8993 1-1/8" (29 mm) 12" (30 cm)

2 DID YOU KNOW...

o Premier cut-to-fit products have a 1/2" (13 mm) starter hole and can
be used as a pre-sized product for some small stomas (excludes high
output pouches, wound drainage collectors and Pouchkins products)

e Cutting guides are provided for all cut-to-fit barriers

e Drainable pouches without an integrated closure include one pouch
clamp per box

¢ \We do not recommend protective wipes be used with extended wear
skin barriers, as they may decrease wear time

e Filtered pouches do not require a cover or sticker when the pouch may
get wet

o Al convex Premier pouches have tape border barriers

o All convex Premier pouches have belt tabs

Drainable Pouches with Convex Barriers (continued)

Upgraded Design Recommended replacement for 851xx/859x series below

828x/829x (PRE-SIZED) Box of 5

> Drainable Pouch < convex
> Flextend (extended wear) Skin Barrier

» With Tape Border

> Without Integrated Filter

> With Belt Tabs

» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

Upgraded Design Features:
» Lock 'n Roll Microseal Closure
with Ribbed Strips and Transparent Flap
» Flexible Release Liner
> Tapered Barrier Edges

HCPCS: A4390

Transparent Beige

Stock No Stock No Barrier Opening Pouch Length
8280 8290 3/4" (19 mm) 12" (30 cm)
8281 8291 7/8 (22 mm) 12" (30 cm)
8282 8292 1" (25 mm) 12" (30 cm)
8283 — 1-1/8" (29 mm) 12" (30 cm)
8284 8294 1-1/4" (32 mm) 12" (30 cm)
8285 8295 1-3/8" (35 mm) 12" (30 cm)
8286 — 1-1/2" (38 mm) 12" (30 cm)
8288 — 1-3/4" (44 mm) 12" (30 cm)

Original Design

851xx/859x (PRE-SIZED) Box of 5

< conex

» Drainable Pouch

> Flextend (extended wear) Skin Barrier

» With Tape Border

> Without Integrated Filter

» With Belt Tabs

> With ComfortiWear Panels
-Transparent — Body Side Only
- Beige — Both Sides

» Lock 'n Roll Closure

HCPCS: A4390

Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
8510 8590 3/4" (19 mm) 2" (30 cm)
8511 8591 7/8" (22 mm) 12 (30 cm)
8512 8592 1" (25 mm) 12" (30 cm)
8513 8593 1-1/8" (29 mm) 12" (30 cm)
8514 8594 1-1/4" (32 mm) 12" (30 cm)
8515 8595 1-3/8" (35 mm) 12" (30 cm)
85116 8596 1-1/2" (38 mm) 12" (30 cm)
— 8597 1-5/8" (41 mm) 12" (30 cm)
85118 — 1-3/4" (44 mm) 12" (30 cm)
85119 — 2" (51 mm) 12" (30 cm)
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Premier One-Piece Pouching System

Drainable Pouches with Convex Barriers (continued)

Design Recommended replacement for 861xx series below

> 8261x (PRE-SIZED) Box of 5
| > Drainable Pouch Includes 1 clamp
| > Flextend (extended wear) Skin Barrier
-/ > With Tape Border < convex
> Without Integrated Filter
- > Clamp Closure

> With Belt Tabs

» With ComfortWear Panels — Body Side Only
Upgraded Design Features:

> Flexible Release Liner

» Tapered Barrier Edges

HCPCS: A4390

Transparent
Stock No Barrier Opening Pouch Length
82610 3/4" (19 mm) 12" (30 cm)
82611 7/8" (22 mm) 12" (30 cm)
82612 1" (25 mm) 12" (30 cm)
82613 1-1/8" (29 mm) 12" (30 cm)
82614 1-1/4" (32 mm) 12" (30 cm)
82615 1-3/8" (35 mm) 12" (30 cm)
82616 1-1/2" (38 mm) 12" (30 cm)
82617 1-5/8" (41 mm) 12" (30 cm)
82619 2" (51 mm) 12" (30 cm)
Original Design

861X (PRE-SIZED) Box of 5

» Drainable Pouch Includes 1 clamp

> Flextend (extended wear) Skin Barrier (

» With Tape Border CONVEX

> Without Integrated Filter

» Clamp Closure

> With Belt Tabs

» With ComfortWear Panels — Body Side Only

HCPCS: A4390
Transparent
Stock No Barrier Opening Pouch Length
8610 3/4" (19 mm) 12" (30 cm)
8611 7/8" (22 mm) 12" (30 cm)
8612 1" (25 mm) 12" (30 cm)
8613 1-1/8" (29 mm) 12" (30 cm)
8614 1-1/4" (32 mm) 12" (30 cm)
8615 1-3/8" (35 mm) 12" (30 cm)
8616 1-1/2" (38 mm) 12" (30 cm)
8617 1-5/8" (41 mm) 12" (30 cm)
8618 1-3/4" (44 mm) 12" (30 cm)
8619 2" (51 mm) 12" (30 cm)

High Output Drainable Pouches

/(,r\ 80070/80110 (CUT-TO-FIT) Box of 10
;)/‘ > Non Sterile, Drainable Pouch
t\",;' » Flextend (extended wear) Skin Barrier — Flat

» Without Tape Border

» With Soft Tap

> With Access Window

» With ComfortWear Panels — Body Side Only

> Without Starter Hole

» No adapter needed to connect to bedside collector

HCPCS: A4435
Ultra-Clear

Stock No For Stomas Up To Pouch Length
80070 2-3/4" (70 mm) 12" (30 cm)
80110 4-1/3" (110 mm) 12" (30 cm)

Wound Drainage Collector

970x/977x

» For Management of Draining Wounds, Fistulae,
or Draining Tube Sites

> Available With and Without FlexIWear (standard wear)
Skin Barriers — Flat

» Without Tape Border

» Sterile and Non Sterile Drainable Pouches

> With Access Window

> Reclosable Cap

» Without Starter Hole

» No adapter needed to connect to bedside collector

HCPCS: A6154
With Barrier: Non Sterile
Stock No Description Quantity/Box
9773 Small (for wounds up to 3") 10
9776 Medium (for wounds up to 3-3/4") 10
9778 Large (for wounds up to 4" x 8") 3
With Barrier: Sterile
Stock No Description Quantity/Box
9701 Small (for wounds up to 3") 5
9702 Medium (for wounds up to 3-3/4") 5
9703 Large (for wounds up to 4" x 8") 3
Without Barrier: Sterile
Stock No Description Quantity/Box
9772 Small (for wounds up to 3") 10
9775 Medium (for wounds up to 3-3/4") 10

7 DID YOU KNOW...

o All high output pouches and wound drainage collectors can be connected
directly into a bedside collector without an adaptor
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Premier One-Piece Pouching System

Closed Pouches with Flat Barriers

82300/82400 (CUT-TO-FIT) Box of 30
> Closed Pouch
» SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
» With Integrated AF300 Filter
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4416

Transparent Beige

Stock No Stock No For Stomas Up To Pouch Length

82400 82300 2-1/8" (55 mm) 9" (23 cm)
82302/82402 (OVAL CUT-TO-FIT) Box of 30

-

Transparent

> Closed Pouch
» SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
» With Integrated AF300 Filter
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4416
Beige

Stock No Stock No For Stomas Up To Pouch Length
82402 82302 3"x2.5" (75 mm x 65 mm) 9" (23 cm)
82100/82500 (CUT-TO-FIT) Box of 30

)

#

» Closed Mini-Pouch

o~ > SoftFlex (standard wear) Skin Barrier — Flat
g > Without Tape Border
» With Integrated AF300 Filter
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
HCPCS: A4416
Transparent Beige
Stock No Stock No For Stomas Up To Pouch Length
82500 82100 2-1/8" (55 mm) 7" (18 cm)
o 823xx (PRE-SIZED) Box of 30

» Closed Pouch

» SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border

» With Integrated AF300 Filter

» With ComfortWear Panels — Both Sides

HCPCS: A4416

Beige

Stock No Barrier Opening Pouch Length
82325 1" (25 mm) 9" (23 cm)
82330 1-3/16" (30 mm) 9" (23 cm)
82335 1-3/8" (35 mm) 9" (23 cm)

Closed Pouches with Flat Barriers (continued)

)

821xx (PRE-SIZED) Box of 30
» Closed Mini-Pouch

o~ > SoftFlex (standard wear) Skin Barrier — Flat
g * E » Without Tape Border
» With Integrated AF300 Filter
> With Comforti/ear Panels — Both Sides
HC416: A4416
Beige
Stock No Barrier Opening Pouch Length
82125 1" (25 mm) 7" (18 cm)
82130 1-3/16" (30 mm) 7" (18 cm)
82135 1-3/8" (35 mm) 7" (18 cm)
Stoma Cap
1796 (PRE-SIZED) Box of 30
» Stoma Cap
y, » SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
» With Integrated Filter
HCPCS: A5055
Beige
Stock No Barrier Opening Size
1796 1-15/16" (50 mm) 4" (102 mm)

For a complete list of Hollister products, refer to the comprehensive

Hollister product catalog online at www.hollister.com.
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Premier One-Piece Pouching System

Urostomy Pouches with Flat Barriers

Recommended replacement for 8440/8450/8460

DeS|gn series below

Urostomy Pouches with Flat Barriers (continued)

Design Recommended replacement for 844x/846x series below

Box of 10
> Urostomy Pouch Includes 2 adapters
> Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
<7 » With Tape Border
> With Comfort\Wear Panels
- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides

Upgraded Design Features:
» Multi-Chamber Design

» Softer, Streamlined Tap

» Tapered Barrier Edges

> Drain Valve Indicator

HCPCS: A4428

Ultra-Clear  Transparent Beige
Stock No Stock No Stock No

Q 84490/84590/84690 (CUT-TO-FIT)

For Stomas Up To  Pouch Length

84590 84690 84490 2-1/2" (64 mm) 9" (23 cm)

Original Design

Box of 10

! Includes 1 adapter

[\~ Uro§tomy Pouch
= {x;?) > Anti-Reflux Valve
e L > Flextend (extended wear) Skin Barrier
» With Tape Border
> With Comfort\Wear Panels
- Transparent and Ultra Clear — Body Side Only
- Beige — Both Sides

HCPCS: A4428

Ultra-Clear  Transparent Beige
Stock No Stock No Stock No

,‘»‘ 8440/8450/8460 (CUT-TO-FIT)

For StomasUp To  Pouch Length

8450 8460 8440 2-1/2" (64 mm) 9" (23 cm)

The upgraded Hollister urostomy pouch is available

in the Premier one-piece pouching system.

The upgraded pouch features several innovations designed to deliver
more comfort and a greater sense of control:

- Skin barrier options to create custom solutions for your patients’
unique needs

> Flat, convex or soft convex

> Tape border

> Flextend (extended wear) skin barrier
> CeraPlus (extended wear) skin barrier

- Enhanced flow-control tap is made with soft material and a
streamlined tap

- Multi-chamber design helps to facilitate even distribution of urine
- Improved adapter helps facilitate ease of use

- Belt tab option (convex)

8449x/8469x (PRE-SIZED) Box of 10
Q » Urostomy Pouch Includes 2 adapters
> Anti-Reflux Valve
; > Flextend (extended wear) Skin Barrier
e » With Tape Border
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides
Upgraded Design Features:
» Multi-Chamber Design
» Softer, Streamlined Tap
» Tapered Barrier Edges
> Drain Valve Indicator
HCPCS: A4428
Transparent Beige
Stock No Stock No Barrier Opening Pouch Length
— 84497 3/4" (19 mm) 9" (23 cm)
84692 — 1" (25 mm) 9" (23 cm)
84698 84498 1-1/4" (32 mm) 9" (23 cm)
84693 — 1-1/2" (38 mm) 9" (23 cm)
84699 84499 1-3/4" (44 mm) 9" (23 cm)
84694 84494 2" (51 mm) 9" (23 cm)

Original Design

f
(]
= /_‘/J f\?)

844x/846x (PRE-SIZED)
» Urostomy Pouch
> Anti-Reflux Valve
> Flextend (extended wear) Skin Barrier
» With Tape Border
» With ComfortWear Panels

- Transparent — Body Side Only

- Beige — Both Sides

HCPCS: A4428

Box of 10
Includes 1 adapter

Transparent Beige

Stock No Stock No Barrier Opening Pouch Length
8467 8447 3/4" (19 mm) 9" (23 cm)
8462 8442 1" (25 mm) 9" (23 cm)
8468 8448 1-1/4" (32 mm) 9" (23 cm)
8463 8443 1-1/2" (38 mm) 9" (23 cm)
8469 8449 1-3/4" (44 mm) 9" (23 cm)
8464 — 2" (51 mm) 9" (23 cm)
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Premier One-Piece Pouching System

Urostomy Pouches with Convex Barriers

Upgraded Design Recommended replacement for 847x/843x series below

P 8479xxx/8439xxx (CUT-TO-FIT) Box of 5
| 9}( » Urostomy Pouch Includes 1 adapter
- » Anti-Reflux Valve

% > Flextend (extended wear) Skin Barrier < cowvex

» With Tape Border

» With Belt Tabs

» With ComfortWear Panels
- Ultra-Clear — Body Side Only
- Beige — Both Sides

Upgraded Design Features:
» Multi-Chamber Design

» Softer, Streamlined Tap

» Tapered Barrier Edges

» Drain Valve Indicator

HCPCS: A4430

Ultra-Clear Beige For Stomas Pouch
Stock No Stock No Up To Length
84794 — 1" (25 mm) 9" (23 cm)
84798 — 1-1/2" (38 mm) 9" (23 cm)
8479111 8439111 2" (51 mm) 9" (23 cm)

Original Design

847xx/843xx (CUT-TO-FIT) Box of 5
@ » Urostomy Pouch Includes 1 adapter

> Anti-Reflux Valve -
- o " » Flextend (extended wear) Skin Barrier (CONVEX
» With Tape Border
» With Belt Tabs
» With ComfortWear Panels
- Transparent — Bodly Side Only
- Beige — Both Sides

HCPCS: A4430

Transparent Beige

Stock No Stock No For Stomas Up To Pouch Length
8474 1" (25 mm) 9" (23 cm)
8478 — 1-1/2" (38 mm) 9" (23 cm)
84711 — 2" (51 mm) 9" (23 cm)

7 DID YOU KNOW...

e eaving urine in the urostomy pouch before connecting to a bedside
collector/leg bag may minimize the suction effect and allow urine to
drain better into the collection system

Urostomy Pouches with Convex Barriers (continued)

Upgraded Design Recommended replacement for 848x/849x series below

A\ 8489x/8499x (PRE-SIZED) Box of 5
M » Urostomy Pouch Includes 1 adapter

AL > Anti-Reflux Valve
= > Flextend (extended wear) Skin Barrier < convex
% > With Tape Border
» With Belt Tabs
» With ComfortWear Panels
- Ultra-Clear — Body Side Only
- Beige — Both Sides

Upgraded Design Features:
» Multi-Chamber Design

» Softer, Streamlined Tap

» Tapered Barrier Edges

» Drain Valve Indicator

HCPCS: A4430

Ultra Clear Beige
Stock No Stock No Barrier Opening Pouch Length
84890 — 1/2" (13 mm) 9" (23 cm)
84891 84991 5/8" (16 mm) 9" (23 cm)
84892 84992 3/4" (19 mm) 9" (23 cm)
84893 84993 7/8" (22 mm) 9" (23 cm)
84894 84994 1" (25 mm) 9" (23 cm)
84895 84995 1-1/8" (29 mm) 9" (23 cm)
84896 84996 1-1/4" (32 mm) 9" (23 cm)
84897 84997 1-3/8" (35 mm) 9" (23 cm)
84898 84998 1-1/2" (38 mm) 9" (23 cm)
84899 84999 1-3/4" (44 mm) 9" (23 cm)
Original Design
p 848x/849x (PRE-SIZED) Box of 5
A - » Urostomy Pouch Includes 1 adapter

.~ > Anti-Reflux Valve
SRS h’fﬂ > Flextend (extended wear) Skin Barrier ( CONVEX
» With Tape Border
> With Belt Tabs
> With ComfortiWear Panels
- Transparent — Body Side Only
- Beige — Both Sides

HCPCS: A4430

Transparent Beige

Stock No Stock No Barrier Opening Pouch Length
8480 — 1/2" (13 mm) 9" (23 cm)
8481 8491 5/8" (16 mm) 9" (23 cm)
8482 8492 3/4" (19 mm) 9" (23 cm)
8483 8493 7/8" (22 mm) 9" (23 cm)
8484 8494 1" (25 mm) 9" (23 cm)
8485 8495 1-1/8" (29 mm) 9" (23 cm)
8486 8496 1-1/4" (32 mm) 9" (23 cm)
8487 8497 1-3/8" (35 mm) 9" (23 cm)
8488 8498 1-1/2" (38 mm) 9" (23 cm)
8489 — 1-3/4" (44 mm) 9" (23 cm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.
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Premier One-Piece Pouching System

Urostomy Pouches with GeraPlus Soft Convex Barriers

Upgraded Design

8413xx (CUT-TO-FIT) Box of 5

@ > Urostomy Pouch
T~ > Anti-Reflux Vialve SOFT
’@;{}) > CeraPlus (extended wear) Skin Barrier CONVEX
3 > With Tape Border i
 With Belt Tabs Clele
» With ComfortiWear Panels — Body Side Only

Upgraded Design Features:
» Multi-Chamber Design

» Softer, Streamlined Tap

» Drain Valve Indicator

> Tapered barrier edges

HCPCS: A4430

includes 1 adapter

Ultra Clear Stock No For Stomas Up To Pouch Length
84134 1" (25 mm) 9" (23 cm)
84138 1-1/2" (38 mm) 9" (23 cm)
841311 2-1/8" (55 mm) 9" (23 cm)

Upgraded Design

55 841X (PRE-SIZED) Box of 5
,,,\ > Urostomy Pouch includes 1 adapter
> Anti-Reflux Valve -

SOFT
» CeraPlus (extended wear) Skin Barrier ( CONVEX
> With Tape Border rami
> With Belt Tabs e
» With ComfortiWear Panels — Body Side Only

Upgraded Design Features:
» Multi-Chamber Design

» Softer, Streamlined Tap

> Drain Valve Indicator

» Tapered barrier edges

HCPCS: A4430

Beige w/Viewing Option

Stock No Barrier Opening Pouch Length
8412 3/4” (19 mm) 9" (23 cm)
8413 7/8" (22 mm) 9" (23 cm)
8414 17 (25 mm) 9" (23 cm)
8415 1-1/8" (29 mm) 9" (23 cm)

Non Sterile Kits — Drainable

89001 (CUT-TO-FIT)
Colostomy/lleostomy Kit Includes:
> (1) 88401 SoftFlex (standard wear) Skin Barrier
» Without Tape Border

» Without Integrated Filter

> Lock 'n Roll Microseal Closure

» Single-Use Package

» With ComfortiWear Panels — Body Side Only

HCPCS: A5061

Box of 5 Kits

Ultra-Clear

Stock No For Stomas Up To Pouch Length
89001 2-1/2" (64 mm) 12" (30 cm)
89002 (CUT-TO-FIT) Box of 5 Kits

Colostomy/lleostomy Kit Includes: 1 clamp per kit
> (1) 88501 SoftFlex (standard wear) Skin Barrier
55 » Without Tape Border
/‘// > Without Integrated Filter
» Clamp Closure
» Single-Use Package
» With ComfortiWear Panels — Body Side Only

HCPCS: A5061
Ultra-Clear

Stock No For Stomas Up To Pouch Length
89002 2-1/2" (64 mm) 12" (30 cm)
- 89003 (CUT-TO-FIT) Box of 5 Kits
’ Colostomy/lleostomy Kit Includes: 1 clamp per kit
-/ > (1) 8651 Flextend (extended wear) Skin Barrier

» With Tape Border

> Without Integrated Filter

» Clamp Closure

» Single-Use Package

» With ComfortWear Panels — Body Side Only

HCPCS: A4388
Ultra-Clear

Stock No For Stomas Up To Pouch Length
89003 2-1/2" (64 mm) 12" (30 cm)
2 89004 (CUT-TO-FIT) Box of 5 Kits

Colostomy/lleostomy Kit Includes:

> (1) 8531 Flextend (extended wear) Skin Barrier
» With Tape Border

» Without Integrated Filter

> Lock 'n Roll Microseal Closure

» Single-Use Package

> With ComfortWear Panels — Body Side Only

HCPCS: A4388

Ultra-Clear

Stock No For Stomas Up To Pouch Length
89004 2-1/2" (64 mm) 12" (30 cm)
Non Sterile Kits — Urostomy

89005 (CUT-TO-FIT) Box of 5 Kits

Urostomy Kit Includes: 1 adapter per kit
> (1) 8450 Flextend (extended wear) Skin Barrier

» With Tape Border

» (1) 7331 Urostomy Drain Tube Adapter

» Single-Use Package

» With ComfortiWear Panels — Body Side Only

HCPCS: A4428

Ultra-Clear
Stock No For Stomas Up To

Pouch Length

89005 2-1/2" (64 mm) 9" (23 cm)

Ia!
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A secure fit is necessary for
I A

preventing leakage and

T

providing patient comfort
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Pouchkins

Pediatric Pouching System
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Pouchkins Pediatric Pouching System

Premie Pouch

3777 (CUT-TO-FIT) Box of 15
» Use as a Premie Closed or Drainable Pouch
Q » SoftFlex (standard wear) Skin Barrier — Flat

» Without Tape Border
» Without Starter Hole
» Without Integrated Filter
» Soft Wire Closure (if drain opening is desired)

HCPCS: A5052 + A4362

Fun Character
Stickers Included!

Ultra-Clear
Stock No For Stomas Up To Pouch Length

3777 5/8" (15 mm) 4-1/2" (11.5cm)

Newborn Pouch

3778 (CUT-TO-FIT) Box of 15
» Newborn Pouch; Use With or Without the Drain Valve
> SoftFlex (standard wear) Skin Barrier — Flat

» Without Tape Border Fun Charach
> Without Starter Hole
» Without Integrated Filter

» Soft Wire Closure (if larger drain opening is desired)

HCPCS: A5062 + A4362

Ultra-Clear
Stock No For Stomas Up To Pouch Length

3778 1-3/8" x 7/8" (35 mm x 22 mm) 6-1/2" (16 cm)

One-Piece Pouches

> Drainable Pouch
» SoftFlex (standard wear) Skin Barrier — Flat

» Without Tape Border
. Fun Ch.
» Without Starter Hole
» Without Integrated Filter
> Lock 'n Roll Microseal Closure

» With ComfortWear Panels — Body Side Only
HCPCS: A5061

4 3796 (CUT-TO-FIT) Box of 10
\ )

Transparent
Stock No For Stomas Up To Pouch Length
3796 1-1/2" (38 mm) 6-1/2" (16 cm)

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.

73



Pouchkins Pediatric Pouching System

One-Piece Pouches (continued)

Two-Piece Skin Barrier

= 3795 (CUT-TO-FIT) Box of 10 3761 (CUT-TO-FIT) Box of 5
S <~ » Drainable Pouch e » SoftFlex (standard wear) Skin Barrier — Flat
= > Softflex (standard wear) Fun Character - > Without Starter Hole
Skin Barrier — Flat Stickers Included! » Without Tape Border
» Without Starter Hole '
» Without Tape Border Transparent HCPCS: A4414
: \Z\gz‘llg}?é’](;;thell?cggzg?(;ggre Stock No Flange Size For Stomas Up To
» With ComfortiWear Panels — Body Side Only 3761 @ 1-3/4" (44 mm) 1-1/4" (32 mm)
HCPCS: A4424 .
Transparent Two-Piece Pouches
Stock No For Stomas Up To Pouch Length 3799 Box of 10
3795 2" (51 mm) 7" (18 cm) \ » Drainable Pouch
> Without Integrated Filter
i 'ip\‘ 3797 (CUT-TO-FIT) Box of 10 / > Lock 'n Roll Microseal Closure
N » Urostomy Pouch Includes 1 adapter — > With Belt Tabs ,
S » Anti-Reflux Valve » With ComfortiWear Panel — Body Side Only
~ > SoftFlex (standard wear) Fun Character HCPCS: A5063
Sk_in Barrier — Flat Stickers Included! Transparent
» Without Starter Hole Stock No Flange Size Pouch Length
» Without Tape Border 3799 @& 1-3/4" (44 mm) 6-1/2" (16 cm)
» With ComfortiWear Panels — Body Side Only
HCPCS: AS071 PN 18292/18282 Box of 20
Transparent P » Drainable Pouch
Stock No For Sto"mas Up To Poucl: Length h«q:d > With Integrated AF300 Filter
3797 1-1/2" (38 mm) 8-3/4" (22 cm) > Lock 'n Roll Microseal Closure
> With Belt Tabs
» With Comfort\Wear Panel
- Transparent — Bodly Side Only
- Beige — Both Sides
HCPCS: A4425
Transparent Beige Pouch
Stock No Stock No Flange Size Length
18292 18282 @& 1-3/4" (44 mm) 7" (18 cm)
S, 18382/18392 Box of 60
S P » Closed Mini-Pouch
= » With Integrated AF300 Filter
» With Belt Tabs
» With ComfortWear Panels
- Transparent — Body Side Only
- Beige — Both Sides
7 DID YOU KNOW... HCPCS: A4419
Transparent Beige . Pouch
Pouchkins SoftFlex skin barrier Stock No Stock No Flange Size Length
18382 18392 @& 1-3/4" (44 mm) 7" (18 cm)

 Designed to be gentle

o No starter hole, which enables the opening to be
placed where needed within the cutting guide

o No tape by design

e Flexible and sized for babies and children

¢ None of the Pouchkins pediatric pouching systems
are made with natural rubber latex

o Any 1-3/4" New Image pouch will fit this skin barrier

74 75



76

Pouchkins Pediatric Pouching System

Two-Piece Pouches (continued)

esign Recommended replacement for 1840x/1841x/1842xx

series below
1890x/1891x/1892x Box of 10
» Urostomy Pouch Includes 2 adapters

» Anti-Reflux Valve
» With Belt Tabs
» With ComfortWear Panels
- Transparent and Ultra-Clear — Body Side Only
o - Beige — Both Sides

Upgraded Design Features:
» Multi-Chamber Design

» Softer, Streamlined Tap

» Drain Valve Indicator

HCPCS: A4432
Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18922 18902 18912 @ 1-3/4" (44 mm) 9" (23 cm)
Original Design
18402/18412/18422 Box of 10
» Urostomy Pouch Includes 1 adapter

> Anti-Reflux Valve

» With Belt Tabs

» With Comfort\Wear Panels
- Transparent and Ultra-Clear — Body Side Only
- Beige — Both Sides

HCPCS: A4432
Ultra-Clear Transparent  Beige Flange Pouch
Stock No Stock No  Stock No Size Length
18422 18402 18412 @& 1-3/4" (44 mm) 9" (23 cm)
Pediatric Ostomy Belt
\J 3774 Single Unit
= ) Ostomy Belt
. - White Color
HCPCS: A4367
Stock No Length
3774 10"- 17" (25 cm-43 cm) Adjustable

2 DID YOU KNOW...

Shadow Buddies dolls

o Exclusive to Hollister, Shadow Buddies
dolls are special friends for children who
have had or will have ostomy surgery

e Great teaching tool to help with education
and care giving

e Huggable dolls with heart-shaped eyes
and a stoma provide comfort and support

To order, see page 93.

Shadow Buddies is a trademark of The Shadow Buddies Foundation




Accessories can enhance

performance of the skin barrier

-y o

and promote healthy skin
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Accessories

Why use an ostomy
accessory”?

Ostomy accessories are used together
with your pouching system. You may use
one or more of these products. Here are
a few reasons why you might want to use
an ostomy accessory:

* |t may help enhance the performance of
your pouching system. For example, an
accessory could help increase wear time,
protect your skin, or make the removal
of your adhesive easier

* [t may help solve a problem such as
leakage or skin irritation

* It may help improve the quality of your
life by eliminating odor



Adapt Barrier Rings

Count on the Right Fit With

Hollister understands that no two people or
stomas are alike — and that barrier rings can play a critical role in

helping ensure the best outcome for your patients

Whether you choose flat or convex, slim or regular, round or oval—

Adapt barrier rings:

® Are designed to be stretched or shaped or cut into pieces to use

as a filler in uneven areas

¢ Help prevent stoma output from getting under the pouch seal,

which may reduce leakage and skin irritation

e Can be cut or stacked together to improve the fit of the

pouching system

¢ Are alcohol free, so there is no sting from alcohol when applied to

broken or irritated skin

Talk to your Hollister ostomy representative about the full line of

Adapt barrier rings, now available with and without ceramide.

. Ostomy Care
% HOlllster Healthy skin. Positive o{tcomes.
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Ostomy Accessories

Adapt Skin Barrier Rings

o

88xx Box of 10
> CeraRing Barrier Rings (Flat) i
> Flextend M (extended wear) with Ceramide LU

HCPCS: A4385

Stock No Outer Diameter Thickness

8805 2" (48 mm) 4.5 mm

8815 2" (48 mm) 2.3 mm @&
78xx Box of 10

&

o

» Barrier Rings (Flat)
> Flextend M (extended wear)

HCPCS: A4385

Stock No Outer Diameter Thickness
7805 2" (48 mm) 4.5mm
7815 2" (48 mm) 2.3 mm@ED
7806 4" (98 mm) 2.3 mm@ED
o - 895xx Box of 10
» CeraRing Round Convex Barrier Rings
& . Flextend (extended wear) with Ceramide < comex
HCPCS: A4411 Ceramide
Stock No Inner Diameter
89520 13/16" (20 mm) — can be stretched to 1" (25 mm)
89530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
89540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)
o 795xx Box of 10
O > Convex Round Convex Barrier Rings (
&)+ Flextend (extended wear) CONVEX
HCPCS: A4411
Stock No Inner Diameter
79520 13/16" (20 mm) — can be stretched to 1" (25 mm)
79530 1-3/16" (30 mm) — can be stretched to 1-3/8" (35 mm)
79540 1-9/16" (40 mm) — can be stretched to 1-3/4" (45 mm)

O

o

o

896xx Box of 10
> CeraRing Oval Convex Barrier Rings C
> Flextend (extended wear) with Ceramide CONVEX

HCPCS: A4411 Ceramide

Stock No Inner Diameter
89601 7/8" x 1-1/2" (22 mm x 38 mm)

— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)
89602 1-3/16" x 1-7/8" (30 mm x 48 mm)

— can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
89603 1-1/2" x 2-3/16" (38 mm x 56 mm)

— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)

o

o

o

796xx Box of 10
> Oval Convex Barrier Rings
> Flextend (extended wear) (CONVEX

HCPCS: A4411

Stock No Inner Diameter
79601 7/8" x 1-1/2" (22 mm x 38 mm)

— can be stretched to 1-1/8" x 1-3/4" (27 mm x 43 mm)
79602 1-3/16" x 1-7/8" (30 mm x 48 mm)

— can be stretched to 1-3/8" x 2-1/8" (35 mm x 53 mm)
79603 1-1/2" x 2-3/16" (38 mm x 56 mm

)
— can be stretched to 1-3/4" x 2-3/8" (43 mm x 61 mm)




Means Everything

A Sense of Security ,

Adapt Barrier Extenders
Three strips create a

X custom frame around
At Hollister Ostomy Care, we know ) i
your skin barrier.
a sense of security and leakage

prevention are top priorities for you.

Our Adapt barrier extenders offer an additional layer of protection
for those concerned about lifting around the edges of their

skin barrier. With a thin and flexible hydrocolloid formulation,
Adapt barrier extenders conform easily to body contours. Three
convenient strips make it easy to create a custom frame around
the skin barrier. The end result is enhanced security, when it

matters most.

. Ostomy Care
% HOlllster Healthy skin. Positive o{tcomes.
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Ostomy Accessories

Adapt Skin Barrier Strips

” 79400 Box of 10
» Skin Barrier Strips

\ > Flextend (extended wear)

HCPCS: A4385
Stock No Size Length
79400 609 5-1/8" (13 cm)
Adapt Barrier Extenders

79402 Box of 30

» Barrier Extenders

» Hydrocolloid Formulation

HCPCS: A4362*
Stock No
79402
* 3 extenders = 1 unit, Box of 30 = 10 billable units
Adapt Skin Barrier Paste

79300/79301
Adapt...

WAE L Non-Adnesive

HCPCS: A4406
Stock No Description Quantity
79300 2.1 0z (60 g) tube Box of 1
79301 0.50z (14 g) tube Box of 20
Adapt Stoma Powder

7906 Box of 1

= HCPCS: A4371
Stock No Description
7906 10z (28.3 g) puff bottle
Adapt Odor Eliminator and Lubricant
= 78500/78501
Lw
= = HCPCS Code: A4394
Stock No Description Quantity
78500 8 0z (236 mL) bottle Box of 1
78501 0.27 0z (8 mL) packet 50 Packets/Box
Adapt Ostomy Belts
—~\ 7300/7299 Box of 10
N
: ¥ HCPCS: A4367

Beige -
Stock No Size
7300 23"-43" (58 cm-109 cm) Medium - Adjustable
7299 34"-65" (86 cm-165 cm) Large - Adjustable

For a complete list of Hollister products, refer to the comprehensive

Hollister product catalog online at www.hollister.com.

Adapt Skin Prepping Product

- 7917 1Box
e » Skin Protective Wipes 50 Wipes Each
> Non-Adhesive

~ Alcohol Free
HCPCS: A5120

Stock No

7917

*Not recommended for use with extended wear skin barriers, as it may decrease wear time

Adapt Adhesives and Removers

7760 1Box
> Universal Remover Wipes 50 Wipes Each
» For Adhesives and Barriers

» Silicone Based NO STING

> Alcohol Free
HCPCS: A4456

Stock No
7760

7737 Box of 1
» Medical Adhesive Remover

» Silicone Based

> Alcohol Free
HCPCS: A4455

Stock No Description
7737 1.7 0z (50 mL) 360° spray can
7730 Box of 1

» Medical-Grade, Silicone-Based Adhesive
> Improves Adhesive Contact Between Skin and Barrier

= HCPCS: A4364
Stock No Description
7730 3.8 0z (112 mL) 360° spray can

Flextend (extended wear) Skin Barrier

8800
8801
Ly HCPCS for 8800: A4385
HCPCS for 8801: A5122
Stock No Size
8800 4x4" (10 cmx 10 cm) Box of 5
8801 8x8" (20 cm x 20 cm) Box of 3
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Ostomy Accessories

Odor Eliminators Other Accessories
= 773x
m9 » m9 Odor Eliminator Spray Loop Ostomy Bridge
g > Neutralizes Odor Rather Than Masking It 187 Box of 20
——= 0X 0
HCPCS: No Code > Sterile
Stock No (unscented) Description Quantity HCPCS: A4421
7732 2 0z (60 mL) pump spray Box of 12 ’
7733 8 0z (240 mL) pump spray Box of 6 Stock No
7767
(Green Apple . . . . .
Stock No  Scented)  Description Quantity Bedside Drainage Collection System with Anti-Reflux Valve
7734 2 0z (60 mL) pump spray Box of 12 N
7735 8 0z (240 mL) pump spray Box of 6 9839 Box of 20
» Sample Port
» Sterile Fluid Pathway
LA 771x i
o » m9 Odor Eliminator Drops ' HCPCS: A_43_57
. Stock No Description
HCPCS: A4394 9839 68 0z (2000 mL) Capacity
Stock No Description Quantity
7715 1 0z (30 mL) bottle Box of 12 i i
7717 8 0z (240 mL) bottle Box of 6 Skin Barrier Pastes and Powders
. 7910 Box of 12
Cleaner/Decrystallizer > Karaya 5Paste
7736 Box of 12 HCPCS: A4405
> m9 Cleaner/Decrystallizer Stock No Description

» Cleans Urinary Drainage Systems
> pH Balanced and Non-Acidic
> Free Wash Bottle Included

HCPCS: A5131 ﬁ 7905 Box of 12

7910 4.5 0z (135 mL) tube

> Karaya 5 Powder

Stock No Description
7736 16 07 (480 mL) hottle HCPCS: A4371
Stock No Description
Drainable Pouch Clamp 7905 2.5 0z (75 mL) puff bottle
// 8770 Box of 20 Skin Barriers
HCPCS: A4363 7800 Box of 5
Stock No Color . ’ ) 0X 0
> Premium (standard wear) Skin Barrier
8770 Beige
HCPCS: A4362
Urostomy Drain Tube Adapter Stock No Size
7800 4x4" (10 cmx 10 cm)
7331 Box of 10
HCPCS: A4421 7700 Box of 5
Stock No > HolliHesive (standard wear) Skin Barrier
7331 HCPCS: A4362
N . Stock No Size
Hollister Universal Catheter Access Port =00 x4 (10cmx 100m)
9779 Box of 8
£ > Graduated nipple and punch allows introduction .
A === Of catheter or drain through pouch Replacement Filters
> Sterile 00) 7766 Box of 5 Packs
Stock No 000 > For use with 3668
9779 » 1 pack contains 20 Filters and 2 Plugs
HCPCS: A4368
Stock No
7766
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Ostomy Accessories

Vented Urinary Leg Bag Combination Pack

9645/9655 Box of 10

> Includes:
(1) Sterile, Vented Urinary Leg Bag — Medium or Large
(1) Sterile, Extension Tubing with Vacuum Relief Valve, (18"
Long, Oval, 11/32" Effective Inside Diameter), with Connector
(1) Pair, Fabric Leg Bag Straps — Medium
(23" Long, 1-1/8" Wide)

> Not Made with Natural Rubber Latex

HCPCS: A4358
Stock No Description Length Width

9645 Medium — 18 oz (540 mL) 10" 4-1/4"
9655 Large — 30 0z (900 mL) 11-1/8" 5"

Urinary Leg Bag Combination Pack

9348/9349 Box of 12
> Includes:
(1) Sterile, Urinary leg Bag — Medium or Large
(1) Non-Sterile, Extension Tubing (18" Long, Oval, 11/32"
Effective Inside Diameter) with Connector
- (1) Pair, Fabric Leg Bag Straps — Medium
(23" Long, 1-1/8" Wide)
>Not Made with Natural Rubber Latex

HCPCS: A4358

Stock No Description Length Width
9348 Medium — 18 0z (540 mL) 10" 4-1/4"
9349 Large — 30 0z (900 mL) 11-1/" 5"
Urinary Leg Bag
] 9814/9805 Box of 10
> Includes:

(1) Sterile, Urinary Leg Bag — Medium or Large
> Not Made with Natural Rubber Latex

HCPCS: A9270

HCPCS: A4358 (if straps are added)
Stock No Description Length Width
9814 Medium — 18 0z (540 mL) 10" 4-1/4"
9805 Large — 30 0z (900 mL) 11-1/8" 5"

Fabric Leg Bag Straps

9342/9343 10 Pair
»Not Made with Natural Rubber Latex

HCPCS: A5114

Stock No Description Length Width
9342 Small 15" 1-1/8"
9343 Medium 23" 1-1/8"
Extension Tubing

9345/9346 Box of 10

> Kink-resistant with Connector

Oval, 11/32” Effective Inside Diameter
» Thermoplastic Elastomer
» Not Made with Natural Rubber Latex

HCPCS: A4331

Stock No Description Length
9345 Non Sterile 18"
9346 Sterile 18"
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Irrigation Products

General Information

» Similar to an enema with the water being placed into the stoma.

> Routine irrigation is recommended to be done on doctor’s orders (to

regulate emptying the bowel at a scheduled time).

» Appropriate for some people with sigmoid or descending colostomies.

> Not appropriate for people with urostomy or ileostomy.
> Allow approximately one hour for irrigation procedure.

721
Kﬂ > Cone Irrigator Kit Includes: -
> (1) Irrigator Irrigation Bag Holds

> (1) Stoma Cone with Connector
> (1) Cleaning Brush

HCPCS: A4398 + A4399

Box of 1

Approximately
1500 CC

Stock No
7721
Kj 7723 Box of 10
» Stoma Cone with Connector
> Replacement Unit
HCPCS: A4399
Stock No
7723
' @ 1460x (CUT-TO-FIT) Box of 5
= > Flextend (extended wear) Skin Barrier
= s With Tape Border
HCPCS: A4409
Stock No Flange Size For Stomas Up To
14602 @& 1-3/4" (44 mm) 1-1/4" (32 mm)
14603 @ 2-1/4" (57 mm) 1-3/4" (44 mm)
14604 @ 2-3/4" (70 mm) 2-1/4" (57 mm))
- 1815x Box of 5
> Drainable Irrigator Sleeve to be used
with New Image Two-Piece System
» Fits any New Image barrier that has a 1-3/4",
- 2-1/4" or 2-3/4" flange, including the
& 1460x series above
> With Belt Tabs
> Includes Clamp
HCPCS: A4397
Transparent
Stock No Flange Size Sleeve Length
18152 @ 1-3/4" (44 mm) 30" (76 cm)
18153 @ 2-1/4" (57 mm) 30" (76 cm)
18154 @ 2-3/4" (70 mm) 30" (76 cm)

7728/7724 Box of 20
> Irrigator Sleeve with Belt Tabs

> Includes Clamp

> A belt is required to secure the sleeve to the body

HCPCS: A4397

O

Stock No Opening Size Sleeve Length

7728 2" (51 mm) 22" (56 cm)

7724 3" (76 mm) 22" (56 cm)
1796 (PRE-SIZED) Box of 30
» Stoma Cap

vy » SoftFlex (standard wear) Skin Barrier — Flat
» Without Tape Border
» With Integrated Filter

HCPCS: A5055

Beige
Stock No Barrier Opening Size
1796 1-15/16” (50 mm) 47 (102 mm)

318x (PRE-SIZED) Box of 30
» Stoma Cap, Tape Adhesive, Integrated Filter,
Odor-Barrier Film, Without Comfort\/ear Panels

HCPCS: A5055

Beige
Stock No Opening Size
3184 2" (51 mm) 4-1/4" (11 cm)
3186 3" (76 mm) 4-1/4" (11 cm)
7300/7299 Box of 10
y » Ostomy Belts
- HCPCS: A4367
Beige
Stock No Size
7300 23"-43" (58 cm-109 cm) Medium
7299 34"-65" (86 cm-165 cm) Large
7740 Box of 10
i » Adapt Stoma Lubricant
=5 > For Use with Stoma Irrigator
HCPCS: A4402
Stock No Description
7740 4 0z (120 mL) bottle

For a complete list of Hollister products, refer to the comprehensive
Hollister product catalog online at www.hollister.com.
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Karaya 5 One-Piece Pouching System

Drainable Pouches

366X (PRE-SIZED) Box of 10
> Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Tape Border, Replaceable < comvex
Filter, Pouch Clamp Closure, Belt Tabs,
Without ComfortiWear Panels. Includes 1 Bag
of 20 Hollister Replacement Filters and 2 Plugs, #7766

HCPCS: A4389 + A4368

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3668 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)

360X (PRE-SIZED) Box of 10

» Drainable Pouch, Karaya 5 (standard wear) (
Skin Barrier—Tape Border, Without CONVEX
Integrated Filter, Pouch Clamp Closure,

Belt Tabs, Without ComfortWear Panels

HCPCS: A4389
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3608 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3603 1-1/2" (38 mm) 1-1/8" (29 mm) 12" (30 cm)
3609 1-3/4" (44 mm) 1-3/8" (35 mm) 12" (30 cm)
3604 2" (51 mm) 1-1/2" (38 mm) 12" (30 cm)
3605 2-1/2" (64 mm) 2" (51 mm) 12" (30 cm)

323X (PRE-SIZED) Box of 30

» Drainable Mini-Pouch, Karaya 5

(standard wear) Skin Barrier— Tape Border, < convex
Without Integrated Filter, Pouch Clamp Closure,

Belt Tabs, Without ComfortWear Panels

HCPCS: A4389
Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3232 1" (25 mm) 5/8" (16 mm) 9" (23 cm)
3238 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
3233 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
3239 1 3/4 (44 mm) 1-3/8" (35 mm) 9" (23 cm)
3234 2" (51 mm) 1-1/2" (38 mm) 9" (23 cm)

322x (PRE-SIZED) Box of 30

> Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Tape Border, Without < comve
Integrated Filter, Pouch Clamp Closure,
Belt Tabs, Without Comfort\//ear Panels

HCPCS: A4389

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3222 1" (25 mm) 5/8" (16 mm) 2" (30 cm)
3228 1-1/4" (32 mm) 7/8" (22 mm) 12" (30 cm)
3223 1-1/2" (38 mm) 1-1/8" (29 mm) 2" (30 cm)
3229 1-3/4" (44 mm) 1-3/8" (35 mm) 2" (30 cm)
3224 2" (51 mm) 1- 1/2 (38 mm) 2" (30 cm)
3225 2-1/2" (64 mm) 2" (51 mm) 2" (30 cm)
3226 3" (76 mm) 2-1/2" (64 mm) 2" (30 cm)

Drainable Pouches (continued)

327x (PRE-SIZED) Box of 30
» Drainable Pouch, Karaya 5 (standard wear)
Skin Barrier— Tape Border, Without < comve
Integrated Filter, Pouch Clamp Closure,
Belt Tabs, Without ComfortWear Panels

HCPCS: A4389

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3278 1-1/4" (32 mm) 7/8" (22 mm) 16" (40 cm)
3273 1-1/2" (38 mm) 1-1/8" (29 mm) 16" (40 cm)
3279 1-3/4" (44 mm) 1-3/8" (35 mm) 16" (40 cm)
3274 2" (51 mm) 1-1/2" (38 mm) 16" (40 cm)
3275 2- 1/2 (64 mm) 2" (51 mm) 16" (40 cm)
3276 3" (76 mm) 2-1/2" (64 mm) 16" (40 cm)

Closed Pouches

332x (PRE-SIZED) Box of 30
» Closed Pouch, Karaya 5 (standard wear)
Skin Barrier— Tape Border, Integrated < conex
Filter, Belt Tabs, Without Comfort\//ear Panels

HCPCS: A4417

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
3328 1-1/4" (32 mm) 7/8" (22 mm) 9" (23 cm)
3323 1-1/2" (38 mm) 1-1/8" (29 mm) 9" (23 cm)
3329 1-3/4" (44 mm) 1-3/8" (35 mm) 9" (23 cm)
3324 2" (51 mm) 1-1/2" (38 mm) 9" (23cm)
3325 2-1/2" (64 mm) 2" (51 mm) 9" (23cm)
3326 3" (76 mm) 2-1/2" (64 mm) 9" (23 cm)

716X (PRE-SIZED) Box of 30

» Closed Pouch, Karaya 5 (standard wear) (
Skin Barrier— Without Tape Border, CONVEX
Without Integrated Filter, Belt Tabs,

Without ComfortWear Panels
> Requires a Belt

HCPCS: A4387

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
7164 2" (51 mm) 1-1/2" (38 mm) 9" (23 cm)

Urostomy Pouches

143x (PRE-SIZED) Box of 10
> Urostomy Pouch, Karaya 5 (standard wear)
Skin Barrier— Tape Border, Belt Tabs, < conex
Without Comfort\Wear Panels

HCPCS: A4429

Transparent Pouch Pouch
Stock No Size Barrier Opening Length
1432 1"(25 mm) 5/8"(16 mm) 9" (23 cm)
1438 1-1/4"(32 mm) 7/8"(22 mm) 9" (23 cm)
1433 1-1/2"(38 mm) 1-1/8"(29 mm) 9" (23 cm)
1439 1-3/4"(44 mm) 1-3/8"(35 mm) 9" (23 cm)
1434 2"(51 mm) 1-1/2"(38 mm) 9" (23 cm)
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Education e Resources

All of the Hollister educational materials listed below
are also available on our website: www.hollister.com

Visit the Hollister YouTube channel for all educational videos

Ostomy Clinical Education Website

Get access to the latest research, educational materials, product evidence,
and training. Inspired by clinicians like you, we've designed this section

of our website to be a resource for both you and the people you care for.
Visit the Ostomy Care, Clinical Education area of our website.
www.hollister.com/en/ostomycare/ostomy-clinical-education

Stoma Measuring Guide 903515
Oval Stoma Measuring Guide 923298
(Printable versions available online at
www.hollister.com/en/ostomycare/educationaltools)

Educational Booklets Literature No
Understanding Your Colostomy 923054
Understanding Your Colostomy (Spanish) (online only) 923234
Understanding Your lleostomy 923055
Understanding Your lleostomy (Spanish)  (online only) 923235
Understanding Your Urostomy 923056
Understanding Your Urostomy (Spanish)  (online only) 923236
Can They Still Wiggle and Giggle? Coloring Book 907617
The Day | Got My Stoma (online only) 910497

Caring for Your Child With an Ostomy — Pediatric (English) 923057

Caring for Your Child With an Ostomy — Pediatric (Spanish) 923257
(online only)

Caring for your Loved One with an Ostomy 923058
Caring for your Loved One with an Ostomy (Spanish) (online only) 923258

DID YOU KNOW...

o All of the educational resources listed are also available online at
www.hollister.com.

e Your patients can also access a library of educational
articles on topics related to ostomy care - ranging from
general ostomy information and maintaining healthy
peristomal skin, to lifestyle changes and how to adapt
to life with a stoma.

91



92

Education e Resources

Ostomy Care Tips Literature No
Aaapt Barrier Rings 923059
Adapt Barrier Extender 923899
Aadapt Convex Barrier Rings 923060
Adapt Lubricating Deodorant 923061
Adapt Medical Adhesive Spray/Adapt Remover Spray & Wipes 923073
Adapt No-Sting Skin Protective Wipe 923079
Adapt Ostomy Belt 923062
Adapt Paste 923063
Adapt Stoma Powder 923064
Colostomy Irrigation (online only) 923065
Using Convexity 923066
Fistula Management (online only) 923067
High Output 923121
lleostomy Dietary Guidelines 923117
Lock ’n Roll Microseal Closure 923068
Medicare Reimbursement Guide 923118
One-Piece Pouching System (English) 923069
One-Piece Pouching System (Spanish) 923070
Ostomy Educational Theatre (online only) 923115
Patient Anatomy Guide 923072
Peristomal Skin Care 923085
Pouchkins Newborn Pouching System (online only) 923119
Pouchkins One-Piece Pouching System (online only) 923074
Pouchkins Premie Pouching System (online only) 923076
Pouchkins Two-Piece Pouching System (online only) 923075
Routine Care of Your Ostomy (English) 923077
Routine Care of Your Ostomy (Spanish) 923078
Stoma Site Selection (online only) 923080
Two-Piece Pouching System (English) 923081
Two-Piece Pouching System (Spanish) 923082
Two-Piece Pouching System with FormaFlex Skin Barrier 923083
(online only)

Types of Ostomies 923084
Universal Catheter Access Port (UCAP) (online only) 923114
Where a Soft Convex Skin Barrier May Improve Fit 923116
Spanish Lit QR sheet 923398
Patient QR Code Sheet 923423
Educational Theater Videos 923429
Living with an Ostomy Booklets Literature No
Travel 923123
Healthy Eating 923124
Sex & Parenthood 923125
Home & Work Life 923126
Sports & Fitness 923127

Pre-Surgery Care Kits Literature No

i~y m  Includes guidebook to facilitate the patient's pre-surgery

“ ¥ visit with a clinician and materials for self-led practice
applying and removing an ostomy pouching system with
a model stoma.

Colostomy Pre-Surgery Care Kit K2025
lleostomy Pre-Surgery Care Kit K2026
... Urostomy Pre-Surgery Care Kit K2027

Patient Discharge Folders

Colostomy Patient Discharge Folder 923261
lleostomy Patient Discharge Folder 923262
Urostomy Patient Discharge Folder 923263

Professional Organizations

Wound, Ostomy and Continence Nurses Society (WOCN)
WWw.wocn.org
1.888.224.9626

Professional Resources

Fit Indicator Tool (FIT)

Fit Indicator Tool (FIT) has been designed to help provide a simple patient
assessment methodology to determine the need for a flat or convex barrier.
Open the app Store or Google Play and search using: “Hollister Education”.

Peristomal Skin Assessment Guide

The Peristomal Skin Assessment Guide helps with assessment and
management of common peristomal skin complications and is available at
the WOCN Society website. Also available for consumer use. psag.wocn.org

Online Education Program

Our Ostomy Care course allows healthcare professionals to learn about
different types of ostomies, problem-solving tips, and additional resources.
It also provides flexibility and the ease of online, anytime e-learning.
www.hollister.com/ostomyelearning

Shadow Buddies ltem No
Light Skin Tone Girl 905439
Light Skin Tone Boy 905440
Medium Skin Tone Girl 905441
Medium Skin Tone Boy 905442
Dark Skin Tone Girl 905443
Dark Skin Tone Boy 905444
Additional Resources Item No
Stoma Model (White Plastic) 858674

Consumer Resources
Hollister Secure Start Services

1.888.808.7456
www.securestartservices.com

United Ostomy Associations of America, Inc. (JOAA)
info@uoaa.org

www.ostomy.org

1.800.826.0826

Pull-Thru Network
pullthrunetwork.org
1-309-262-0786

Crohn’s and Colitis Foundation of America (CCFA)
www.ccfa.org
1.800.932.2423

Shadow Buddies
www.shadowbuddies.org
1.913.642.4646
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Education e Glossary

AF300 Filter: “AF” stands for air flow and “300” represents the 300
mm? air flow surface area on every AF300 filter.

Ceramide: A natural component of the human skin that links the cells
of the stratum corneum together to form a waterproof protective barrier.
This helps prevent water loss that can lead to skin damage and dryness.

CeraPlus Skin Barrier: A skin barrier that has all the basic
characteristics of an ostomy skin barrier (adhesion, absorption, and
erosion resistance) and is infused with ceramide. CeraPlus is an example
of an extended wear skin barrier.

Closed Pouch: A pouch without an opening at the bottom. Quick and
easy to discard. It must be removed to be emptied.

Colostomy: An ostomy (surgical opening) created in the colon, part
of the large intestine.

ComfortWear (pouch) Panels: Provide a soft cloth between the pouch
film and the skin.

Convex Skin Barrier: A skin barrier shaped to press more deeply
around the stoma. May be used when the stoma does not protrude from
the abdomen.

Cut-to-Fit Skin Barrier: A skin barrier that can be customized to a
needed size and shape. Ideal for stomas that are not round or stomas
that are still changing in size.

Drainable Pouch: A pouch with an opening at the bottom. An integrated
closure system or plastic clamp is used to keep the pouch closed until it
is time to empty it.

Filter: Releases gas but not odor out of the pouch. The key performance
factors of any filter are air flow, deodorization, and liquid protection.

Flange: The plastic ring in a two-piece ostomy system that is used to
connect the skin barrier and pouch together.

Flat Skin Barrier: May be used when the stoma protrudes from the
abdomen.

Flextend Skin Barrier: A skin barrier designed to be durable and
resistant to liquid discharge. Flextend is an example of an extended wear
skin barrier.

FlexWear Skin Barrier: A skin barrier designed to be worn more than
one day. A FlexWear skin barrier is designed to be more resistant to
breakdown than a SoftFlex skin barrier. FlexWWear is an example of a
standard wear skin barrier.

Floating Flange: Type of skin barrier flange found on Hollister two-piece
pouching systems that allows you to put your fingers under the skin
barrier flange while attaching the pouch.

FormaFlex Skin Barrier: A skin barrier that can be stretched to fit the
size and shape of the stoma without the use of scissors. It is a barrier

option in the New Image two-piece pouching system. FormaFlex is an

example of an extended wear skin barrier.

lleostomy: A sugically created opening in the last portion of the small
intestine.

Irrigation: A procedure sometimes used by individuals with a colostomy
to control bowel elimination. It is not for everyone with a colostomy and
requires special equipment and instruction by a knowledgeable healthcare
provider.

Lock ’n Roll Microseal Closure: Integrated system for closing the
bottom of drainable pouches. Utilizes plastic interlocking fasteners to
create a secure closure. Found on New Image, Premier, and Pouchkins
drainable pouches.

Medical Adhesive-Related Skin Injury (MARSI): Occurrences in which
erythema and/or other manifestation such as blister, tear or other injury
persists more than 30 minutes after removal of medical adhesive.

Odor-Barrier Pouch: Is highly resistant to letting odors pass through
the pouch film. The odor barrier quality increases confidence when wearing
a pouch.

Peristomal Moisure-Associated Skin Damage (PMASD): Inflammation
and erosion of the skin adjacent to the stoma, associated with exposure to
effluent such as urine or stool.

Pre-Sized Skin Barrier: A skin barrier that is already cut to the
proper size.

QuietWear Pouch Material: Material comprised of a pouch film and
ComfortWear panel that are laminated together. This special design
results in the reduction of the pouch rustling noise.
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Education e Glossary

SoftFlex Skin Barrier: A skin barrier that provides gentle adhesive
attachment to the skin. SoftFlex is designed to limit skin damage with
frequent removal and can be changed daily (or more often). SoftFlex is an
example of a standard wear skin barrier.

Stoma: A surgically created opening in the gastrointestinal or urinary
tract. Also known as an ostomy. The stoma is pink and moist and
doesn’t have feeling.

Urostomy: A surgically created opening into the urinary system; drains
urine and sometimes mucus.

Urostomy Pouches: Pouch with a drain tap at the bottom so urine
can be emptied quickly and easily.

Wear Time: The length of time a product can be worn before failure.
Wear time varies widely based upon a variety of factors.

Education e Enterocutaneous Fistula Management

Key Goals for Nursing Management

e Protect the skin — The output from a fistula can be very irritating to
the skin. Broken skin contributes to pain and discomfort. A skin barrier
can protect the skin from contact with the drainage.

e Contain the output — If the output is minimal, gauze dressings may
be sufficient for containment. However, if the volume of the output from
the fistula is significant or frequently overwhelms the dressing, a pouch
may be more appropriate. Using a pouch can be more efficient and can
protect healthcare providers from exposure to bodily fluids.

e Measure the output — With a high output fistula, loss of fluids
and electrolytes can be a major concern. Measuring the drainage is
easier using a pouching system. Sometimes connecting a pouch to a
bedside collector can relieve the stress on the pouch, so the wear time
improves.

e Manage costs — Care of fistulas can be costly in terms of supplies
and human resources. Using a pouching system and appropriate
accessories can be more cost-effective and manageable than frequent
dressing changes.

e Control odor — Containment of the drainage in a pouching system,
even in small quantities, can manage odor effectively. Other accessory
products can also assist with odor control when the pouch is changed
or emptied.

e Provide patient comfort — Effectively managing a fistula can
contribute to patient dignity. Protecting the skin, collecting the
discharge, containing costs, and controlling odor all contribute to
patient comfort.

Nix, D & Bryant, R. (2016). Fistula Management, Chapter 17 in Carmel, J.E., Colwell, J.C., & Goldberg, M.T.

(Eds). Wound Ostomy and Continence Nurses Society Core Curriculum Ostomy Management. Wolters Kluwer, PA.
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Index e Stock Number

Stock No Page(s)  Stock No Page(s)  Stock No Page(s) Stock No Page(s)  Stock No Page(s)  Stock No Page(s)
120X, . ..ooe 15,29 1820%. ..o 39 332X 89 7KK .o 78 848X........... .. 69 89001 ........... 71

1140, ... ..o 15, 32 1828x. ... 38 360X, ... 88 T96XX. ..o 78 8489%............ 69 89002 ........... 71

11650x. .. ... 15, 34 18282 ........ 38,75 366X, ... 88 80070 ........... 63 849, ... 69 89003 ........... 71

M7 16, 36 1829%. ..o 38 3761 ... 75 80110 ........... 63 8499x............ 69 89004 ........... 71

Moo 16, 36 18292 ........ 38,75 3774 76 8031 ............ 50 850XX. ... 58 89005 ........... 71

1340%. ..o 33 1832%.. ..o 40 3777 oo 73 8081 ............ 49 851XK. v 61 891X, ...l 19, 56
1350%. ..ot 35 1833, .o 4 3778 ... 73 8131 ... 50 8O2XX. ... 58 891xx......... 19, 56
130X, oo 34 1835, ..o 4 3795 ... 74 8181 ........ ... 49 853X, ... 52 8931 ......... 17,48
1410, ..ol 31 1836X. ... 40 3796 ... 73 821X, .o 65 8531 ... 48 895xx. .. 18, 23, b5, 78
1420, ..o 29 1837X. .o 40 3797 ... 74 82100 ........... 64 854X . ... 51 896X.......... 18, 55
143X, oo 89 1838X. ..o 4 3799 ... 75 823XX. .. 64 850X, ... 52 896xX......... 23,78
1430%. ..ol 31 18382 ........ 41,75 7164 ... 89 823x00........... 58 8551 ... ... 48 898X.......... 19, 56
1440%. . ... .. 33 183%. ..o 4 7299 ... 80 82302 ........... 64 857XX. .. 55 898xx......... 19, 56
1450%. ... 35 18392 ........ 41,75 7300 ... 80 824xX. ... 58 858XX. ... 57 899x.......... 19, 60
1460%. .. ... e 86 1840%. .. ....o s 42 7331 o 82 82400 ........... 64 859K, .. 61 970X, ..o 63
1470, ... 30 18402 ........ 42,76 7700 ... 83 82402 ........... 64 861X, ......... ... 62 77X 63
1480%. . ..o 32 1841 . 42 TX oo 82 82500 ........... 64 862XX. . ... 59 9779 ... 82
149X . .o 34 18412 ... 42,76 7721 86 8261%............ 62 8631 ............ 49 9839 ... 83
1510, ..o 15,29 1842¢. ... 42 7723 ... 86 8262x............ 59 863X............. 52

1520%. .o 30 18422 ........ 42,76 724 87 827XX. .. 57 8641 ............ 49

1830 ...l 32 1873%. ..o 4 7728 ... 87 828X. ... 61 864X, . ... 52

1540%. ...l 33 1875%. ..o 4 TI3%. ..o 82 829X, ... 61 8651 ............ 49

1550%. .o 34 1890x. ..o 42 7730 ... 81 8331 ............ 48 866X............. 56

1560X. . ..ot 29 1891%. ..o 42 7736 ... 82 8371 ............ 48 867XK. ..o 55

1580%. ...l 32 1892x. ... 42 7737 oo 81 8381 ............ 49 8770 ............ 82

1590%. .o 35 1900, ..o 43 7740 ... 87 841X, ... 20, 70 88xX. . ... 23,78

1610, .. ..oovee s 30 1905%. ..o 45 7760 ... 81 8413xx........ 20,70 8800 ............ 81

1640%. . ... oL 31 1910%. ..o 43 7766 ... ... 83 843X .. 68 8801 ............ 81

179 ......... 65, 87 1915%. .o 45 7767 ... 83 843X, ... 68 883xX. . ... 53

1800%. ... vovvt 38 1920%. ..o 44 T, v 78 844X, ............ 67 88300 ........... 50

1801, .ol 40 1925 .o 46 7800 ............ 83 8440 ............ 66 88302 ........... 51

1810, .o 39 1930%. .o 44 78500 ........... 80 8449x........ ... 67 884xx. . ... 53

181X .o 38 1935%. ..o 45 78501 ........... 80 84490 ........... 66 88400 ........... 50

812X oo 39 1940x. ..o 44 7905 ... 83 8450 ............ 66 88401 ........... 51

1813, oo 38 1950, ..o 46 7906 ............ 80 84590 ........... 66 88402 ........... 51

1814x. ...l 39 1960%. . ....... 21,43 7910 ... 83 8460 ............ 66 88501 ........... 51

1815, .ol 86 1980x. . ....... 21,43 TN7 ..o 81 846X............. 67 887XX. ... 53

1816X. ..o 39 318 ..o 87 79300 ........... 80 8469x............ 67 88700 ........... 50

1817% oo 39 322X 88 79301 ... 80 84690 ........... 66 88800 ........... 50

1818X. .o 38 323K . 88 79400 ........... 80 84TXX. .. 68 8IXX. ... 17, 51

1819, .o 38 327X ..o 89 79402 ... 80 847X .. 68 8901 ......... 17,48
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Index e Product Name

Name

A 0D BAITIEr EXIBNUETS .......oovveeooeeeees e
Adapt CeraRing Convex Barrier Rings
Adapt CeraRing Flat Barrier Rings

Adapt CeraRing Oval Convex Barrier RiNGS .........cccvviirinreniesienisnennins 23,78
Adapt Odor Eliminator and LUBFCaNt..............cccoeevviieiiiieiiceceeeees 80

AdaPt OSOMY BEIS ... 80
Adapt SKIN BArfer RINGS.........vvireiiisseieiesssens s 78
Adapt SKIN BAITIEr PASTE..........cvvvereiieieiieieeees e 80
Adapt SKIN BATIEr SHIDS.....cvvviveieiieiieecs e s 80
Adapt SKin Prepping PrOGUCT .......c..cvierierciessienessesee s 81
Adapt SOMA POWAET ..o 80
Adapt AdNesIVES and REMOVETS .........covveriiiieiieeeees s 81
Bedside Drainage Collection Systwm with Anti-Reflux Valve ............coooveoeveveeenene, 83
CeraPlus Convex Skin Barriers with Integrated Floating Flange............

CeraPlus Soft Convex Skin Barriers with Integrated Floating Flange...

CeraPlus Flat Skin Barriers with Integrated Floating Flange ............c.coovcevenan.
EXtENSION TUDING ...v...oooeveeees e 85
Drainable POUCH ClaMD ..........ovevveeeeeeeeeeeseeeeeeceeessesee e 82
Drainable Pouches with CeraPlus Flat Barriers.......... 17, 48, 51
Drainable Pouches with CeraPlus Soft Convex Barriers . .18, 55-56
Drainable Pouches with CeraPlus Convex Barmiers ..., 19, 56, 60
Flextend (extended wear) SKIN BarTier..............ovvvecemreveereeeneereereeeseeereccseesneneees 81
Fabric Leg Bag SrapS ........cvveierciiiseesss s 85
High Output Drainable POUCKES............ovvveeoeeeeeeeeeeneeree e 40, 63
Hollister Universal Catheter ACCESS POIT ............viviiiviriisiissesierenis 82
ITiQAtiON PrOGUCES. ..........vvveeoeeeeeeeecoeeseeeeceeseeeeee e 86-87
Irrigator Sleeves ...

Karaya 5 Closed POUCKES ..........oovceecerreeveeeseseeeeeceeesseveee e 89
Karaya 5 Drainabl POUCNES ..........veviiiiiiiieeisee e 88-89
Karaya 5 UroSotmy POUCNES ..........cvuriiiiirieecsie s 89
LoOP OStOMY BIIAGE .......ovvveeoevveeeeeeeeseeeeee e 83

MY Cleaner/Decrystallizer ...
M9 OdOr ENMINATONS. ...

New Image Closed POUCKES................coovvvveeeeiseeeeriesseeeeecseesssseeseessseseen
New Image Soft Convex Skin Barrier with Integrated Floating Flange.
New Image Convex Skin Barriers with Integrated Floating Flange.....................
New Image Drainable POUCNES ..........covvriiiieiieeeeess e
New Image Flat Skin Barriers with Integrated Floating Flange
New Image High Output Drainable Pouches ..
New Image Non Sterile Kits - Drainable..... .
New Image Non Sterile Kits - UrOStOMY ........c.vvrrnrrirnnsseesseeeenenns
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General Information

HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide
general information concerning coding of Hollister products only. Hollister
does not guarantee coverage or payment for any products. The ultimate
responsibility for proper coding, satisfying reimbursement requirements,
and obtaining reimbursement remains with the provider. Coding and
coverage policies and guidelines are complex, can vary from one carrier
or region to another, and are updated frequently. Providers should check
with their local carriers or intermediaries often and should consult with
counsel, a reimbursement specialist, and/or the DMECS website for any
coding, coverage, reimbursement, or billing questions.

HCPCS codes shown in this Product Catalog are current as of January 2018.

General Medicare Product Maximum Allowables of
Selected Ostomy Products

Two-Piece Pouching Systems Maximum Quantity per Month

Flat, Standard Wear Skin Barriers with Floating Flanges 20
Drainable Pouches 20
Closed Pouches 60
Urostomy Pouches 20
Irrigator Sleeves 4
One-Piece Pouching Systems Maximum Quantity per Month
Drainable Pouches with Flat, Standard Wear Skin Barriers 20
Closed Pouches with Flat, Standard Wear Skin Barriers 60
Stoma Caps 31
Pediatric Pouching Systems Maximum Quantity per Month
One-Piece Drainable and Urostomy Pouches 20
Two-Piece Skin Barriers 20
Two-Piece Drainable and Urostomy Pouches 20
Two-Piece Mini Closed Pouches 60
Pediatric Ostomy Belt 1
Accessories Maximum Quantity per Month
Skin Barrier Rings *
Skin Barrier Paste 40z

Stoma Powder

Lubricating Deodorant
Ostomy Belt 1
Skin Protective Wipes 150/6 months

10 0z/6 months

Note: Medicare allows a usual maximum quantity of supplies each month. The table above
provides the maximum allowable amounts. The amount of supplies you need may vary from
the maximum quantities. That will be determined by your physician and must be on your
order and in your medical record. If you require more ostomy supplies than what is listed

in the table, your physician will need to provide a medical justification for the additional
supplies. The ostomy supplier will need to have that medical justification on file when billing
the Medicare program for the additional supplies.

* No usual maximum amount established.

Reimbursement For Fistula Management by Medicare

Reimbursement for fistula management under the Medicare program
is described in the Surgical Dressings Policy Article. Specifically the
article states:

“Surgical dressings are covered when either of the following criteria
are met:
1. They are required for the treatment of a wound caused by, or
treated by, a surgical procedure; or

2. They are required after debridement of a wound.”
The article goes on to explain:

“Examples of situations in which dressings are noncovered under the
Surgical Dressings benefit are:

a. Drainage from a cutaneous fistula which has not been caused by
or treated by a surgical procedure”

For information see The Fistula Management Care Tip on www.hollister.com

Latex Statement

All Hollister Ostomy Care products found in this catalog and its packaging
does not include natural rubber latex as a component, and our component
suppliers do not add natural rubber as part of their production process.

Prior to use, be sure to read the Instructions for Use for information
regarding intended use, contraindications, warnings, precautions and
instructions.

2 DID YOU KNOW...

Supplier Matching

“Having a supplier that can provide your preferred products
when you need them is important. If you are having a difficult
time finding a supplier who provides your preferred products,
please call 888-808-7456 to learn your options.”

- Secure Start Member

Hollister Secure Start services can connect patients with a supplier
of their choice based on their insurance plan for the products you
recommend. The amount of supplies they need may vary from the
maximum allowable quantities, but this is determined
by a physician and should be included on the patient’s
order and medical record. For additional assistance,
visit www.securestartservices.com or call us at
1.888.808.7456.
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Medicare Utilization Chart

Medicare’s Usual Maximum Quantity for Ostomy Supplies

The quantity of ostomy supplies needed by a patient is determined A4390  Ostomy pouch, drainable, with extended wear barrier *
primarily by the type of ostomy, its location, its construction, and attached, with built-in convexity (one-piece), each

the condition of the skin surface surrounding the stoma. There will be A4391  Ostomy pouch, urinary, with extended wear barrier *
variation according to individual patient need and their needs may vary attached (one-piece), each

over time. The table below lists the maximum number of items/units A4392  Ostomy pouch, urinary, with standard wear barrier *
of service that are usually medically necessary. The actual quantity attached, with bui-in onvexity {one-piece), each

. . A4393  Ostomy pouch, urinary, with extended wear barrier *
lr)fzte(ée((ji for adpartlculterl]r pfatutant Tﬁ yt b?‘f m?rtﬁ O:c less than t?% a”.“’“”t q attached, with built-in convexity (one-piece), each
ISted depending on the Tactors that affect the frequency ot barrier an A4394  Ostomy deodorant, with or without lubricant, for use in *

pouch change. The medical necessity for use of a greater quantity of ostomy pouch, liquid, per fluid ounce
supplies than the amounts listed must be clearly documented in the 4395  Ostomy deodorant for use in ostomy pouch, solid, *
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patient’s medical record, and must be available upon request. If adequate
documentation is not provided when requested, the excess quantities will

be denied as not medically necessary.

Per Medicare LCD for Ostomy Supplies (L33828), effective 1-1-2020.

A4331  Extension drainage tubing, any type, any length, with
connector/adapter, for use with urinary leg bag
or urostomy pouch, each

A4357 Bedside drainage bag, day or night, with or without
anti-reflux device, with or without tube, each

A4361 Ostomy faceplate, each

A4362 Skin barrier, solid, 4 x 4 or equivalent, each

A4363 Ostomy clamp, any type, replacement only, each

A4364 Adhesive, liquid or equal, any type, per ounce

A4366 Ostomy vent, any type, each

A4367 Ostomy belt, each

A4368 Ostomy filter, any type, each

A4369 Ostomy skin barrier, liquid (spray, brush, etc.), per ounce
A4371  Ostomy skin barrier, powder, per ounce

A4372  Ostomy skin barrier, solid 4 x 4 or equivalent, standard wear
with built-in convexity, each

A4373  Ostomy skin barrier, with flange (solid, flexible, or accordion),
with built-in convexity, any size, each

A4375  Ostomy pouch, drainable, with faceplate attached, plastic, each
A4376  Ostomy pouch, drainable, with faceplate attached, rubber, each

A4377 Ostomy pouch drainable for use on faceplate,
plastic, each

A4378  Ostomy pouch, drainable, for use on faceplate, rubber, each
A4379 Ostomy pouch, urinary, with faceplate attached, plastic, each
A4380 Ostomy pouch, urinary, with faceplate attached, rubber, each
A4381 Ostomy pouch, urinary, for use with faceplate, plastic, each

A4382  Ostomy pouch, urinary, for use on faceplate,
heavy plastic, each

A4383  Ostomy pouch, urinary, for use on faceplate, rubber, each
A4384 Ostomy faceplate equivalent, silicone ring, each

A4385  Ostomy skin barrier, solid 4 x 4 or equivalent, extended wear,
without built-in convexity, each

A4387 Ostomy pouch, closed, with barrier attached, with built-in
convexity (one-piece), each

A4388  Ostomy pouch, drainable, with extended wear barrier
attached, (one-piece), each

A4389 Ostomy pouch, drainable, with barrier attached, with built-in
convexity (one-piece), each

* No established usual maximum, refer to Medicare Utilization Guidelines.

2 ea/mo

3 ea/6 mo
20 ea/mo

*

4 0z/mo

1 ea/mo

2 0z/mo
10 0z/6 mo

*

*

*

10 ea/mo

*

*

*

10 ea/mo

*

per tablet
A4396  Ostomy belt with peristomal hernia support
A4397 Irrigation supply, sleeve, each
A4398 Ostomy irrigation supply, bag, each
A4399 Ostomy irrigation supply, cone/catheter, with or without brush
A4402  Lubricant, per ounce
A4404  Ostomy ring, each
A4405 Ostomy skin barrier, non-pectin based, paste, per ounce
A4406 Ostomy skin barrier, pectin-based, paste, per ounce
A4407  Ostomy skin barrier, with flange (solid, flexible, or

accordion), extended wear, with built-in convexity,
4 x 4 inches or smaller, each

A4408 Ostomy skin barrier, with flange (solid, flexible, or accordion),
extended wear, with built-in convexity, larger than 4 x 4
inches, each

A4409 Ostomy skin barrier, with flange (solid, flexible, or accordion),
extended wear, without built-in convexity, 4 x 4 inches
or smaller, each

A4410 Ostomy skin barrier, with flange (solid, flexible, or accordion),
extended wear, without built-in convexity, larger than 4 x 4
inches, each

A4411  Ostomy skin barrier, solid 4 x 4 or equivalent, extended
wear, with built-in convexity, each

A4412  Ostomy pouch, drainable, high output, for use on a
barrier with flange (two-piece system), without filter, each

A4413  Ostomy pouch, drainable, high output, for use on a
barrier with flange (two-piece system), with filter, each

A4414  Ostomy skin barrier, with flange (solid, flexible, or
accordion), without built-in convexity, 4 x 4 inches or
smaller, each

A4415  Ostomy skin barrier, with flange (solid, flexible, or
accordion), without built-in convexity, larger than
4 x 4 inches, each

A4416  Ostomy pouch, closed, with barrier attached, with filter
(one-piece), each

A4417  Ostomy pouch, closed, with barrier attached, with
built-in convexity, with filter (one-piece), each

A4418  Ostomy pouch, closed, without barrier attached, with
filter (one-piece), each

A4419  Ostomy pouch, closed, for use on barrier with
non-locking flange, with filter (two-piece), each

A4420 Ostomy pouch, closed, for use on barrier with locking
flange (two-piece), each

A4421  Ostomy supply; miscellaneous

A4422  Ostomy absorbent material (sheet/pad/crystal packet)
for use in ostomy pouch to thicken liquid stomal
output, each

* No established usual maximum, refer to Medicare Utilization Guidelines.

*

4 ea/mo

2 ea/6 mo
2 €a/6 mo

4 0z/mo
10 ea/mo
4 0z/mo
4 0z/mo

*

*

*

20 ea/mo

20 ea/mo

60 ea/mo

60 ea/mo

60 ea/mo

60 ea/mo

60 ea/mo
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Medicare Utilization Chart

HCPCS Long Description Quantity

A4423  Ostomy pouch, closed, for use on barrier with locking 60 ea/mo
flange, with filter (two-piece), each

A4424  Ostomy pouch, drainable, with barrier attached, with filter 20 ea/mo
(one-piece), each

A4425  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
non-locking flange, with filter (two-piece system), each

A4426  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
locking flange (two-piece system), each

A4427  Ostomy pouch, drainable, for use on barrier with 20 ea/mo
locking flange, with filter (two-piece system) each

A4428  Ostomy pouch, urinary, with extended wear barrier *
attached, with faucet-type tap with valve (one-piece), each

A4429  Ostomy pouch, urinary, with barrier attached, with built-in 20 ea/mo
convexity, with faucet-type tap with valve (one-piece), each

A4430 Ostomy pouch, urinary, with extended wear barrier *
attached, with built-in convexity, with faucet-type tap
with valve (one-piece), each

A4431  Ostomy pouch, urinary, with barrier attached, with 20 ea/mo
faucet-type tap, with valve (one-piece), each

A4432  Ostomy pouch, urinary, for use on barrier with 20 ea/mo
non-locking flange, with faucet-type tap with valve
(two-piece), each

A4433  Ostomy pouch, urinary, for use on barrier with 20 ea/mo
locking flange (two-piece), each

A4434  Ostomy pouch, urinary, for use on barrier with 20 ea/mo
locking flange, with faucet-type tap with valve
(two-piece), each

A4435  Ostomy pouch, drainable, high output, with extended *
wear barrier (one-piece system), with or without filter, each

A4450  Tape, non-waterproof, per 18 square inches 40 ea (18 sq in)/mo

A4452  Tape, waterproof, per 18 square inches 40 ea (18 sq in)/mo

A4455  Adhesive remover or solvent (for tape, cement, or other 16 0z/6 mo
adhesive), per ounce

A4456  Adhesive remover, wipes, any type, each *

A5051  Ostomy pouch, closed, with barrier attached 60 ea/mo
(one-piece), each

A5052  Ostomy pouch, closed, without barrier attached, 60 ea/mo
(one-piece), each

A5053  Ostomy pouch, closed, for use on faceplate, each 60 ea/mo

A5054  Ostomy pouch, closed, for use on barrier with flange 60 ea/mo
(two-piece), each

A5055  Stoma Cap 31 ea/mo

A5056  Ostomy pouch, drainable, with extended wear barrier 40 ea/mo
attached, with filter, (one-piece), each

A5057  Ostomy pouch, drainable, with extended wear barrier 40 ea/mo
attached, with built-in convexity, with filter, (one-piece), each

A5061 Ostomy pouch, drainable, with barrier attached 20 ea/mo
(one-piece), each

A5062  Ostomy pouch, drainable, without barrier attached 20 ea/mo
(one-piece), each

A5063  Ostomy pouch, drainable, for use on barrier with flange 20 ea/mo
(two-piece system), each

A5071  Ostomy pouch, urinary, with barrier attached 20 ea/mo
(one-piece), each

A5072  Ostomy pouch, urinary, without barrier attached 20 ea/mo
(one-piece), each

A5073  Ostomy pouch, urinary, for use on barrier with flange 20 ea/mo

(two-piece), each

* No established usual maximum, refer to Medicare Utilization Guidelines.

HCPCS Long Description Quantity

A5081  Continent device, plug for continent stoma 31 ea/mo
A5082 Continent device, catheter for continent stoma 1 ea/mo
A5083  Continent device, stoma absorptive cover for continent stoma 150 ea/mo
A5093  Ostomy accessory, convex insert 10 ea/mo
A5102 Bedside drainage bottle with or without tubing, rigid or 2 ea/6 mo
expandable, each
A5120  Skin barrier, wipes or swabs, each 150 ea/6 mo
A5121  Skin barrier, solid, 6 x 6 or equivalent, each 20 ea/mo
A5122  Skin barrier, solid, 8 x 8 or equivalent, each 20 ea/mo
A5126  Adhesive or non-adhesive, disk or foam pad 20 ea/mo
A5131  Appliance cleaner, incontinence and ostomy 1 ea (16 oz btl)/mo
appliances, per 16 ounce
A9270  Non-covered item or service *

* No established usual maximum, refer to Medicare Utilization Guidelines.

9

DID YOU KNOW...

Supplier Matching

“Having a supplier that can provide your preferred products
when you need them is important. If you are having a difficult
time finding a supplier who provides your preferred products,
please call 888-808-7456 to learn your options.”

- Secure Start Member

Hollister Secure Start services can connect patients with a supplier
of their choice based on their insurance plan for the products you
recommend. The amount of supplies they need may vary from the
maximum allowable quantities, but this is determined
by a physician and should be included on the patient’s
order and medical record. For additional assistance,
visit www.securestartservices.com or call us at
1.888.808.7456.
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The spirit of Hollister
remains the same
today as it did in 1921.

Our Mission

To make life more rewarding
and dignified for the people
who use our products

and services.

Our Vision

To grow and prosper as an
independent, employee-owned
company and in the process

become better human beings.

OQur Heritage

The roots of Hollister Incorporated date

back to 1921, when 23-year-old entrepreneur
John Dickinson Schneider founded a small
printing company in Chicago, which he named
JDS Printer Craftsman. From the very beginning,
John Schneider’s business philosophy was “only
first class is good enough,” and the company
became known for its quality products, quality
service, and quality people.

The Hollister logo, Adapt, Adapt CeraRing, AF300, CeraPlus, ComfortWear, Flextend, Flextend M,
FlexWear, FormaFlex, HolliHesive, Karaya 5, Lock 'n Roll, m9, New Image, Pouchkins, Premier,

Premium, QuietWear, Secure Start, SoftFlex, and “Healthy skin. Positive outcomes.”, are trademarks of
Hollister Incorporated.

Remois is a technology of Alcare Co., Ltd.
All other trademarks and copyrights are the property of their respective owners.



Monday - Friday
8:00am - 5:00pm (CT)

1.888.808.7456

1.888.808.7456
FAX 1.877.321.7805

Hollister Secure Start Services

Enroll on the Go
Clinician Assisted Enrollment

Access to personalized, no-cost support for ostomy
patients is easier—with mobile device enrollment!
Call us with any questions at 1.888.808.7456.
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Discretion by design

Introducing a discreet catheter with design that is truly inspired.

The Infyna Chic catheter was designed with input from clinicians to help provide a
high level of discretion for women who use catheters. It is beautiful and easy to use.
The Infyna Chic catheter can help a woman feel better about having to use one.

Call to request a sample today! 1.888.808.7456 SO

Infyna Chic

Intermittent Catheter

% Hollister Continence Care



Infyna Chic Intermittent Catheters

Stoliser Iniyna Gii < I

|

Scan to
Request a
Free Sample

Infyna Chic Intermittent Catheter

81xx-30 Box of 30
» Discreet to Carry > Does Not Stain Common Fabrics*
> Ready to Use, Prehydrated if the Contents are Spilled
Hydrophilic Catheter » Does Not Leak Liquid when
> Flip-top Cap Can be Opened Reclosed
and Closed with One Hand » Catheter Length Helps Give

> Just Right Catheter Stiffness Helps  Confidence Bladder is Fully
Support Easy, Touch-free Insertion  Drained

HCPCS: A4351

Stock No Length (inches) Size Description
8108-30 5 8 Fr Straight
8110-30 5 10 Fr Straight
8112-30 5 12Fr Straight
8114-30 5 14 Fr Straight

*Common fabrics include cotton, denim, and polyester.



With 100% No Touch Protection,
whatever you touch won't touch

VaPro catheters.

The protective tip and sleeve of VaPro catheters have been
tested and have been shown to prevent the transmission of
bacteria that may cause UTIs. Don't settle for anything less
than 100% No Touch Protection.

Call to request a sample today! 1.888.808.7456

VaPro

No Touch Intermittent Catheter

% Hollister: Continence Care



VaPro No Touch Intermittent Catheters

VaPro Plus No Touch Hydrophilic Intermittent Catheter

l 74xxx-30 Box of 30
poge :':_ > Protective Tip and Sleeve Allows for > Smooth Hydrophilic Coating
B i No Touch Catheterization » Smooth Eyelets
> Prehydrated, Ready to Use > Not Made with Natural

.E] E]p‘ > Integrated 1000 mL Collection Bag Rubber Latex
AL Hopes: adzsa

Rggﬂgst? a2  Stock No Length (inches) Size Description
Free Sample  74122-30 8 12 Fr Straight
74142-30 8 14 Fr Straight

74124-30 16 12 Fr Straight

74144-30 16 14 Fr Straight

2  DID YOU KNOW...

VaPro No Touch hydrophilic intermittent catheter offers
the right balance of ease of use and protection:

 Prehydrated and ready to use e Packaging is designed with finger holes to
o Protective sleeve allows for the catheter be easy to open
to be gripped anywhere and is proven to ® \/aPro Plus catheter has an integrated
prevent the transmission of pathogens that 1000ml collection bag for catheterization at
may cause UTls home or on the go
e Protective tip helps shield the sterile catheter e Offered in pocket-size packaging for easy
during insertion from bacteria located within transportation and discreet out of home
the first 15mm of the distal urethra usage




VaPro No Touch Intermittent Catheters

VaPro Plus Pocket No Touch Hydrophilic

Intermittent Catheter
T1xxx-30 Box of 30
» Full Length No Touch Catheter » Smooth Eyelets
in a Pocket Size Package > Not Made with
> Protective Sleeve Natural Rubber Latex

> Integrated 1000 mL Collection Bag > Protective Tip

HCPCS: A4353

RSeEflgst?a Stock No Length (inches) Size Description

Free Sample  71082-30 8 8Fr Straight
71102-30 8 10Fr Straight
71122-30 8 12Fr Straight
71142-30 8 14Fr Straight
71084-30 16 8Fr Straight
71104-30 16 10Fr Straight
71124-30 16 12Fr Straight
71144-30 16 14Fr Straight
71164-30 16 16Fr Straight

= = VaPro Coudé No Touch Hydrophilic Intermittent Catheter

E¥-[E  73xx Box of 30

8 > Protective Tip » Smooth Eyelets

EB5%a . Protective Sleeve > Not Made with Natural

Rsca” 0 » Prehydrated, Ready to Use Rubber Latex
equest a P

Free Sample > Coudé Tip
HCPCS: A4352
Stock No Length (inches) Size Description
73124 16 12 Fr Coudé
73144 16 14 Fr Coudé
73164 16 16 Fr Coudé




Hollister Secure Start Services
Personalized Support For You

We’re here to help.

If you have questions about finding the right intermittent catheter, sorting
out insurance coverage, or connecting with community resources,
we're here to help. You don’t have to figure it out on your own.

Call or visit us today to learn more!
1.888.808.7456 | www.securestartservices.com

I I 11 M t Hollister Secure Start services offer free support for catheter users for as
O IS er long as you need it, regardless of the brand of products you use.



Onli Hydrophilic Intermittent Ca

b7

[E)¥u(s]
i
Scan to

Request a
Free Sample

Onli Hydrophilic Intermittent Catheter

82xxx-30

> Ready to Use, Prehydrated
Hydrophilic Catheter

> Easy Touch-free Insertion

> Sliding Gripper* and Funnel
Length Help Provide Control

> Catheter has a Balance of

Box of 30

» Easy to Open Packaging

> Does Not Stain Common
Fabrics™ if the Contents
are Spilled

» Smooth Eyelets

> Not Made with Natural

Flexibility and Rigidity Rubber Latex

HCPCS: A4351

Stock No Length (inches) Size Description
82081-30 7 8 Fr Straight
82101-30 7 10 Fr Straight
82121-30 7 12 Fr Straight
82141-30 7 14 Fr Straight
82084-30 16 8 Fr Straight
82104-30 16 10 Fr Straight
82124-30 16 12 Fr Straight
82144-30 16 14 Fr Straight
82164-30 16 16 Fr Straight

*Sliding gripper only on 16" catheter.

**Common fabrics include cotton, denim, and polyester.



Looking for a catheter that’s easy to use?

Meet Onli.

Hydrophilic Intermittent Catheter

Onli catheters are prehydrated and ready to use right out of the
package with no extra steps required, and the funnel length and
sliding gripper* help provide control during insertion. Try for yourself
and see how easy it is to use Onli catheters.

Call to request a sample today! 1.888.808.7456

*Sliding gripper is only on 16" catheters.

% Hollister Continence Care
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Advance Plus Intermittent Catheter
TSI SRR R I 3
\ g

Request a
Free Sample

Scan to
Request a
Free Sample

Advance Plus Intermittent Catheter System

94xxx/95XXX Box of 100
> Gel Reservoir

> Protective Tip

» 1500 mL Collection Bag with Large Handle

» Smooth Eyelets

> Not Made with Natural Rubber Latex

HCPCS: A4353

Stock No Length Size Description
94064 16 6 Fr Straight
94084 16 8 Fr Straight
94104 16 10 Fr Straight
94124 16 12 Fr Straight
94144 16 14 Fr Straight
94164 16 16 Fr Straight
94184 16 18 Fr Straight
95124 16 12 Fr Coudé
95144 16 14 Fr Coudé
95164 16 16 Fr Coudé

Advance Plus Pocket Intermittent Catheter System

93xxx

Box of 100

> Full Length Advance Plus Catheter in a Pocket Size Package

HCPCS: A4353

Stock No Length Size Description
93104 16 10 Fr Pocket
93124 16 12 Fr Pocket
93144 16 14 Fr Pocket
93164 16 16 Fr Pocket




Advance Plus Intermittent Cathe

i Advance Plus Intermittent Catheter Kit
ROtiARL AR ?Lﬁf 96XXX/97XXX Box of 100
. ),;‘// > Advance Plus Catheter
{6 > Kit Contains Gloves, Underpad Drape, and Benzalkonium

Chloride Swabsticks
> Not Made with Natural Rubber Latex

"

@)%z HCPCS: A4353

) Stock No Length Size Description
E%=4 96004 16 6Fr Straight
Scanto 96084 16 8 Fr Straight
Requesta 96104 16 10 Fr Straight
Free Sample 96124 16 12 Fr Straight
96144 16 14 Fr Straight

96164 16 16 Fr Straight

96184 16 18 Fr Straight

97124 16 12 Fr Coudé

97144 16 14 Fr Coudé

97164 16 16 Fr Coudé

1



Scan to
Request a
Free Sample

Apogee Intermittent Catheters

Apogee IC Intermittent Catheter
10xx/10xxx/11xxx Box of 30

> Smooth Eyelets
> Not Made with Natural Rubber Latex

HCPCS: A4351 for all except
HCPCS: A4352 for xxx26

Length
Stock No (inches) Size Description
10806 6 8 Fr Firm
11006 6 10Fr Firm
11206 6 12Fr Firm
11406 6 14 Fr Firm
11446* 6 14 Fr Firm
10610 10 6 Fr Firm
10810 10 8 Fr Firm
11010 10 10 Fr Firm
10616 16 6 Fr Firm
10816 16 8 Fr Firm
11016 16 10 Fr Firm
11216 16 12Fr Firm
11416 16 14 Fr Firm
11616 16 16 Fr Firm
11816 16 18 Fr Firm
10826 16 8 Fr Coudé
11026 16 10 Fr Coudé
11226 16 12Fr Coudé
11426 16 14 Fr Coudé
11626 16 16 Fr Coudé
11826 16 18 Fr Coudé
1061 16 14 Fr Soft
1065 16 14 Fr Firm, Curved Package

*No funnel  Qty: 30/box except curved catheters: 50/box



Apogee Intermittent Catheters

b e
Apogee Plus Intermittent Catheter

R TR Bxx/Bxxx Box of 100

i Apogee Plus System

> Protective Tip
> Pre-lubricated

» Smooth Eyelets

> 1500 mL Collection Bag
>

Scan to Not Made with Natural Rubber Latex
Request a
Free Sample

HCPCS: A4353

Stock No Length Size Description
B8F 16 8 Fr Firm
B10F 16 10 Fr Firm
B12F 16 12Fr Firm
B14F 16 14 Fr Firm
B16F 16 16 Fr Firm
B18F 16 18 Fr Firm
B12C 16 12Fr Coudé
B14C 16 14 Fr Coudé
B16C 16 16 Fr Coudé
B12S 16 12Fr Soft
B14S 16 14 Fr Soft
B14F-Female 6 14 Fr Firm

13



=k

it

—
Apogee Plus Inermittent Catheter

O]
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Scan to
Request a
Free Sample

T
B

Apogee Plus System Kit

BxxB/BxxxB Box of 100
> Apogee Plus Catheter
> Kit Contains Gloves, Underpad Drape,

Gauze, and PVP Swabsticks
> Not Made with Natural Rubber Latex
HCPCS: A4353
Stock No Length Size Description
B6FB 16 BFr Firm
B8FB 16 8Fr Firm
B10FB 16 10 Fr Firm
B12FB 16 12 Fr Firm
B14FB 16 14 Fr Firm
B16FB 16 16 Fr Firm
B18FB 16 18 Fr Firm
B12CB 16 12 Fr Coudé
B14CB 16 14 Fr Coudé
B16CB 16 16 Fr Coudé
B12SB 16 12 Fr Soft
B14SB 16 14 Fr Soft
B14FB-Female 6 14 Fr Firm




Scan to
Request a
Free Sample

Male External Cathe

InView Silicone Male External Catheters
974xx/975xx/976xX Box of 30
974xx-100/975xx-100/976xx-100 Box of 100

> Self-Adhesive
> (Clear Material Enables Monitoring of Skin
> Not Made with Natural Rubber Latex

HCPCS: A4349
SPECIAL: shorter length sheath

Stock No Stock No

Box of 30 Box of 100 Color Size
97425 97425-100 ] 25 mm
97429 97429-100 ] 29 mm
97432 97432-100 ] 32mm
97436 97436-100 | 36 mm
97441 97441-100 | 41 mm
STANDARD: the daily catheter for general use

Stock No Stock No

Box of 30 Box of 100 Color Size
97525 97525-100 | ] 25 mm
97529 97529-100 ] 29 mm
97532 97532-100 | 32 mm
97536 97536-100 ] 36 mm
97541 97541-100 ] 41 mm
EXTRA: 70% more adhesive than Standard for added security

Stock No Stock No

Box of 30 Box of 100 Color Size
97625 97625-100 ] 25 mm
97629 97629-100 ] 29 mm
97632 97632-100 ] 32mm
97636 97636-100 | 36 mm
97641 97641-100 ] 41 mm

15
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Scan to
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Male External Catheters

Extended Wear Latex Male External Catheters

920x Box of 30
Self-Adhesive

Unique Inner Flap

Easy Applicator Collar
Contains Natural Rubber Latex

HCPCS: A4349

vyvYyvyy

Stock No

Box of 30 Color Size
9206 | 22 mm-25 mm
9207 ] 26 mm-30 mm
9208 ] 31 mm-35 mm
9209 u 36 mm-39 mm

Caution: This product contains natural rubber latex which may cause allergic reactions.

Everyday Latex Male External Catheters
910x Box of 30

> Self-Adhesive
> Easy Applicator Collar
> Contains Natural Rubber Latex

HCPCS: A4349

Stock No

Box of 30 Color Size
9106 u 22 mm-25 mm
9107 u 26 mm-30 mm
9108 ] 31 mm-35 mm
9109 u 36 mm-39 mm

Caution: This product contains natural rubber latex which may cause allergic reactions.
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Leg Bag Systems

Vented Urinary Leg Bag Combination Pack
9645/9655 Box of 10

> Includes:
(1) Sterile, Vented Urinary Leg Bag — Medium or Large
(1) Sterile, Extension Tubing with Vacuum Relief Valve, (18"
Long, Oval, 11/32" Effective Inside Diameter), with Connector
(1) Pair, Fabric Leg Bag Straps — Medium
(23" Long, 1-1/8" Wide)
> Not Made with Natural Rubber Latex

HCPCS: A4358

Stock No Description Length Width
9645 Medium — 18 oz (540 mL) 10" 4-1/4"
9655 Large — 30 0z (900 mL) 11-1/8" 5"

Urinary Leg Bag Combination Pack
9348/9349 Box of 12

> Includes:
(1) Sterile, Urinary Leg Bag — Medium or Large
(1) Non-Sterile, Extension Tubing (18" Long, Oval, 11/32"
Effective Inside Diameter) with Connector
(1) Pair, Fabric Leg Bag Straps — Medium
(23" Long, 1-1/8" Wide)
> Not Made with Natural Rubber Latex

HCPCS: A4358

Stock No Description Length Width
9348 Medium — 18 0z (540 mL) 10" 4-1/4"
9349 Large — 30 0z (900 mL) 11-1/8" 5"

17



Leg Bag Systems

] Urinary Leg Bag
9814/9805 Box of 10
ETaE > Includes:
>, q“’ (1) Sterile, Urinary Leg Bag — Medium or Large
!E] > Not Made with Natural Rubber Latex
—Fd
Scan to
Requesta HCPCS: A9270
& Free Sample HCPCS: A4358 (if straps are added)
& Stock No Description Length Width
9814 Medium — 18 oz (540 mL) 10" 4-1/4"
9805 Large — 30 0z (900 mL) 11-1/8" 5"

?  DID YOU KNOW...

Hollister Leg Bags Offer Many Benefits:

o Comfort with soft, vinyl material ® Reduced risk of pressure with protected
e Discreet profile with pleats strap connection buttons

e Strap security with wide, woven fabric  Helps decrease urine back flow with

* Minimal dexterity needed with easy-to- anti-reflux valve

operate drain valve




Scan to
Request a
Free Sample
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Request a
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Leg Bag Accessories

Fabric Leg Bag Straps
9342/9343 10 Pair
> Not Made with Natural Rubber Latex

HCPCS: A5114

Stock No Description Length Width
9342 Small 15" 1-1/8"
9343 Medium 23" 1-1/8"

Extension Tubing
9345/9346 Box of 10

> Kink-resistant with Connector

Oval, 11/32" Effective Inside Diameter
» Thermoplastic Elastomer
> Not Made with Natural Rubber Latex

HCPCS: A4331

Stock No Description Length
9345 Non Sterile 18"
9346 Sterile 18"

19
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Request a
Free Sample

Collection Systems

Bedside Drainage Collection System
with Anti-Reflux Valve

9839 Box of 20

» Sample Port

» Sterile Fluid Pathway

> Not Made with Natural Rubber Latex

HCPCS: A4357

Stock No Description Length Width

9839 68 0z (2000 mL) 12" 9-3/4"




Collection Systems

Male Urinary Pouch

0 External Collection Device*
9873 Box of 10

Cut-to-Fit, Flextend Skin Barrier
Thin and Flexible

No Additional Tape Needed
Odor-Barrier Film

Convenience Drain

Not Made with Natural Rubber Latex

vy YyYvYyvyyvyy

HCPCS: A4326

Stock No Description Length Width
9873 Male Urinary Pouch 7-1/2" 4-1/2"
9811 Box of 10

@55 E > Cut-to-Fit, SoftFlex Skin Barrier

> Qdor-Barrier Film
[OfseH > Convenience Drain
Scan o > Tape Strips and Skin Gel Wipe Included
Requesta > Not Made with Natural Rubber Latex
Free Sample
HCPCS: A4326
Stock No Description Length Width
9811 Male Urinary Pouch 7-1/2" 4-1/2"

*Meant to be connected to leg bag or gravity drainage

21
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Collection Systems

Female Urinary Pouch External Collection Device*
9840 Box of 10

> Cut-to-Fit, SoftFlex Skin Barrier

> Qdor-Barrier Film

> Convenience Drain

> Alternative to Indwelling Catheter for Bedridden Females
> Adapt Paste, Tape Strips, and Skin Gel Wipe Included

> Not Made with Natural Rubber Latex

HCPCS: A4328
Stock No Description Length Width

9840 Female Urinary Pouch 7-1/2" 4-1/2"

*Meant to be connected to leg bag or gravity drainage



HCPCS Codes Disclaimer

The reimbursement information provided herein is intended to provide general information
concerning coding of Hollister products only. Hollister does not guarantee coverage or
payment for any products. The ultimate responsibility for proper coding, satisfying
reimbursement requirements, and obtaining reimbursement remains with the provider.
Coding and coverage policies and guidelines are complex, can vary from one carrier or
region to another, and are updated frequently. Providers should check with their local
carriers or intermediaries often and should consult with counsel, a reimbursement
specialist, and/or the DMECS website for any coding, coverage, reimbursement, or billing
questions.

HCPCS codes shown in this Product Catalog are current as of November 2020.

Latex Statement

The specifications for the Hollister Continence Care products listed below include natural
rubber latex as a component; our suppliers add natural rubber latex as part of the
production process. If a Hollister product(s) found in this catalog is not listed below,

the specification for that product(s) and packaging does not include natural rubber latex
as a component, and our component suppliers do not add natural rubber as part of their
production process.

Current Stock Numbers:

9106 9206
9107 9207
9108 9208
9109 9209

Prior to use of ALL continence care products, be sure to read the Instructions for Use for information regarding Intended Use,
Contraindications, Warnings, Precautions, and Instructions.

Allintermittent catheters are Rx Only. 23



Stock No  Page Stock No  Page

81xx-30 3 975xx-100 15
74xxx-30 5 976xx-100 15
71xxx-30 6 920x 16
73xXxX 6 910x 16
82xxx-30 8 9645 17
94xxx 10 9655 17
95XxxX 10 9348 17
93xxx 10 9349 17
96xXX 11 9814 18
9Q7xxxX 11 9805 18
10xx 12 9342 19
10xxx 12 9343 19
11xxx 12 9345 19
Bxx/Bxxx 13 9346 19
BxxB/BxxxB 14 9839 20
974xx 15 9873 20
975xx 15 9811 20
976xx 15 9840 22

974xx-100 15
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Contact Us!
Questions about our products or services?

1.888.808.7456

For orders only:
1.800.323.4060
Fax 1.847.680.1017

Hollister Incorporated
2000 Hollister Drive
Libertyville, lllinois 60048

www.hollister.com

The Hollister logo, Adapt, Advance Plus, Apogee, Apogee IC, Apogee Plus, Everyday, Extended Wear, Flextend, Infyna Chic, InView, Onli,
Secure Start, Softflex, VaPro, VaPro Plus, and VaPro Plus Pocket are trademarks of Hollister Incorporated.
© 2020 Hollister Incorporated. 922530-1120 US-01294

% Hollister
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